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PREFACE 

The Macimosh is a new kind of machine that has moved away from dependence on a 
keyboard, and has replaced many of the keyboard's functions with a small device 
called a mouse . You use the mouse to point at icons on the screen, to tell the machine 
what you want to do. T his basic principle is carried through all aspects of the 
machine's functioning from the operating system itself through Mac Write, MacPaint 
and all the other applications software which the Macintosh supports. 

Although the Macintosh is simple to use, this does not mean that it is limited only to 
coping with simple tasks. Its range of facilities is extensive and its unique way of 
working, in fact, gives it great potential. This is to be seen particularly in the software 
package MacPaint. Al l in all , Macintosh is a powerful machine and you will be seeing 
in the course of this book how that power can be harnessed . 

Who this book is for 

This book is for beginners and more experienced people a like. What you should have 
in common is having bought your Macintosh for use in a business environment. If you 
have been usi ng Mac Write for letters, then you can find out how to extend your know­
ledge of the package to using it for reports, advertisements, invitations, notices and 
many other practical applications. For the word processing beginner, I shall be start­
ing with how to use each of MacWrite's facilities to design a useful piece of work. 

You may have found that you have had a lot of fun doodling with MacPaint while the 
boss is out of the o ffice, but I aim to show you how to produce diagrams and pictures to 
impress them when they get back. So whether or not you have started to use MacPaint, 
you will be seeing how to get the most benefit from this extra-ordinary package. 

What this book is about 

This book aims to explore what the Macintosh has to offer the business user . I shall 
begin by looking at the basics of how the machine, its operating system and its software 
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work in practice. Through a series of practical examples for you to practise with , I shall 
describe how to use all the important facilities of the machine. I shall then go on to 
show the kinds of business applications that Mac Write and MacPaint can be used for. 
The book divides into groups of chapters on each subject. 

Finder 

The Macintosh's operating system is called Finder . It is designed to make all the basic 
file-handling processes of the machine as straightforward as possible. In Chapter I I 
shall show you how to use its facilit ies to move, copy and delete your fi les, all by using 
the mouse. 

Mac Write 

Sophisticated word processing powers that are easy to use- that sums up Mac Write. 
Chapters 2, 3 a nd 4 are devoted to looking at all its fac ilities and showing you how to 
make the best of them in writing letters, produci ng advertisements, reports, invoices 
and for many other business uses. 

MacPaint 

A package that can draw pictures sounds rather like a gimmick, but MacPaint is a 
remarkable tool for designing a nything from a new company logo to overhead slides. 
Its facilities are consistent with those of Finder and Mac Write in that they are easy to 
use and yet powerful . They take you into a whole new area of expertise. In chapters 5, 6 
and 7 I shall be introducing you to all its faci lities and showing you how to design your 
own advertisements, illustrated instruction manuals and visual aids- all with the aid 
of a mouse. 



CHAPTER 1 

Introduction to the Macintosh 

In this first chapter I shall introduce the basic features of the Macintosh. This is not 
intended to be a technical introduction. I shall concentrate on how the machine works 
and how you can use it. 

Before you start to use the MacWrite and MacPaint packages which come with the 
Macintosh, it is worth spending a little time finding out about basic operations like 
moving around the screen, opening and closing files, making copies and deleting files. 
It is these aspects of the Macintosh that I shall look at in this first chapter, beginning 
with a brief look at the machine itself. 

The Machine 

Throughout this book the Macintosh I shall be referring to is a standard Macintosh 
with one integral microdisk drive, 128k memory, keyboard, mouse and Imagewriter 
printer . The only software I will have on the machine is Mac Write and MacPaint. I 
shall be using the standard 400k microdisks. 

As a machine, Macintosh has quite a number of novel features. As a preliminary to 
talking about the operating system and how it works, I am going to spend a couple of 
pages on the particular features of the Macintosh machine and how these features 
affect the working of the machine in general. 

To begin with, the screen and the central processor come in one unit. This does not 
affect the working of the computer particularly but it does make it easier to move the 
machine around and it also means that the machine takes up less desk space. 

Instead of using the standard 5.25" floppy disks, Macintosh uses 3.75" disks which 
have a hard plastic coating. A metal spring-loaded shutter fits over the exposed area of 
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the magnetic disk (see Figure 1.1). This type of disk is a distinct improvement over 
normal floppy disks in that its hard covering makes it less prone to damage than a 
floppy, which bends very easily. T he metal shutter over the exposed area of the di sk 
makes it harder to get damaging fingerprints on the delicate surface. 

Disk label 

Disk locking---+-1111 
notoh '-------' 

• 0 

prot~cti ~ du.ttt~r 

Figure 1.1: Macintosh Disk 

The machine is portable although I find that it is perhaps a bit heavy for carrying any 
great distance. A carrying case makes it easier to carry. 

On machines sold outside the USA, words have been replaced by ' icons' on both the 
machine a nd keyboard. This confused me at first because the Macintosh manual refers 
to the keys by their names, which on the British version are not marked. To clarify this 
for later reference I have reproduced the keyboard and annotated it with the meaning 
o f the symbols. (See Figure 1.2.) 

Shi ft 
Shift 

Figure 1.2: Macintosh keyboard 
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In additio n to the keyboard there is a mouse attached to the Macintosh . This small 
device is designed to let you move aro und the screen without having to use the key­
boa rd . It also controls a number of other functions which I shall discuss in greater 
detail further on. 

The Macintosh screen is laid out in quite a different way fro m most other machines 
Instead of starting with an A> prompt as many machines do, it has a series of 'icons', 
or p ictures to represent the choices which are available. The icons themselves play a 
significant role in the operation o f the machine a nd so I have given them a section of 
their own. The screen is referred to as the Desktop and I have illustrated it in Figure 
1.3 . 

Figure 1.3: Desktop 

The information o n the Desktop comes in a series of windows which look lik e that in 
Figure 1.4. When you load the System disk , a System disk window opens au toma­
ticall y to revealt he conten ts of the disk. If you want to examine the contents of o ne of 
the files o r folders on the disk, you open its window. When you do tha t , the new 
window will appear on the Deskto p over the top of the System disk window. You can 
open as many windows as you like and they will overlap one another. As you close 
them, so the previously opened windows wi ll reappear on the screen . 

3 
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Figure 1.4: Macintosh Window 

The Icons 

l 

On many makes of microcomputer, files and commands are issued to the operating 
system by means of the keyboard- you type in the command and the name of the fi le 
next to an A> prompt. This means that before you can do anything you have to know 
the name of the file and the correct command . Providing you know both you can issue 
a command such as the following 

A> pip b: = a:letter *.doc 

(copy all the files with the suffix .doc and the word 'letter' at the beginning from drive a 
to drive b). Or 

A> ren david.dbf = graham.dbf 

(change the name of the graham.dbf file to david.dbf). 

Macintosh replaces this method of operation by using icons to represent the files, disks 
and other available tools. It allows you to move from one to another, to open, close 
and delete files by using the mouse. In this way you can actually see what you are 
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doing; you are physically reproducing the action a nd so it is much easier to remember 
how to manipulate your fi les than with the commands, filenames and syntax of the 
more t radi tional machine. 

The Mouse 

The mouse is the most important device in the use of your Macintosh. It lets you move 
arou nd the screen and manipulate files, d isks, words and pictures. 

T he movements of the mouse are reproduced on the screen by a n arrow. Unlike the 
conventional cursor on other machines , its movements are not restricted to up, down , 
right and left. It can move in any direction. 

T he raised pad on the top of the mouse is used for manipulating the files, disks and 
other features on the Desktop. The pad can be used in a variety of ways which I shall be 
describing in the next section. 

Using the mouse 

Using the mouse is a question o f gelling familiar with it. In this section, I shall look at 
the different ways to move the mouse around. It is a good opportunity to get used to 
how each of these movements works. 

As I said above, the mouse takes over a lot o f the functions usually provided by special 
additional keys on other computer keyboards. I have a lready ment ioned four of those 
- the direction arrow keys. Let 's take a look at some of the other things the mouse will 
do. In describing what the mo use will do, I have adopted the terminology used in the 
Macintosh manuals which should be fami liar to you . 

Selecting options - 'clicking' 

When you start to use your machine, the screen shows two icons- System Disk (or 
Write/ Paint) and Wastebasket. The d isk icon will already be highlighted. T his indi­
cates that any further operation you select will be carried our on that particular disk . 
You can cha nge this by moving the a rrow to a nother of the icons and pressing once on 
the pad (this is called 'clicking'). T he new icon will now be highlighted and the others 
wi ll revert to their normal colour. The same applies not only to the disk icon but also to 
the files and folders it contains. 

5 



MASTER YOUR MACINTOSH SOFTWARE 

6 

Opening files- 'double-clicking' 

With the arrow on the highlighted icon, give the mo use pad two quick presses. This is 
called double-clicking a nd is the quickest method of opening a file or folder . When you 
have done that, a window will open on the screen a nd its contents will be displayed. If 
you open a fo lder which co mains files, repeating the double-click while the arrow is on 
one of them will open it in turn. The only constraint to this is that you will find you 
cannot open specific system files- those represented by the Macintosh icon . 

Moving the icons- 'dragging' 

If you want to rearrange any of the icons on the screen or in the windows, you can do so 
by using the mouse to pull them around. You do this by positioning the mouse on the 
icon you want to move and, pressing down on the mouse pad, pull the icon towards the 
point you want to put it. When you are 'dragging' an icon, initially only a dotted 
outline of the icon will move. The icon itself moves to its new position once you release 
the mouse pad. 

The windows can also be repositioned using the same method, starting with the arrow 
on the top line of the window. 

You wi ll find that dragging icons around the screen is the most commonly used action 
on the Macintosh so you can be sure you wi ll begetting plenty of practice in doing it. 

Enlarging the windows 

In a window where there are a large number of files, not all of them will be displayed in 
the norma l-sized window. I f you want to see them a ll, you can make the window larger 
by placing the arrow on the bottom righthand square (see Figure 1.5) and dragging the 
corner outwards. This stretches the size of the window. You can reverse this process by 
dragging the corner inwards. 

Close Box Ul System Disk 

2 i••ms 2351c in dislc 1641c ovoilob 

0 0 .2 

Empty Folder System Folder 

~ 
1¢1 I 1¢ IQ+ 

I 
Scroll bar 

Figure 1.5: Parts of the Window 

Move the window 

Moke window 
larger or s maller 
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Scrolling 

An alternative to enlarging the window is to scroll it to see all its contents. At the 
righthand side and the bottom of the window are two boxes with an arrow at each end. 
By putting the arrow in these boxes and dragging it up and down or left and righ t, you 
can scroll the window. 

Moving files 

If you want to move files from one folder to another this can also be done by dragging 
them. You open the folder containing the file, and the folder you want to move it to. 
Select and then drag the file icon from one fo lder to the other and then release it. 

Deleting files 

In order to delete a file you must put it in the Wastebasket. To do this you must move to 
the file you want to delete, select it and drag it over to the Wastebasket. To ensure that 
it actua lly goes into the Wastebasket you must position the fi le over the Wastebasket 
icon so that it is highlighted . If it is not correctly placed, then the file will still be visible, 
superimposed on the Wastebasket. 

Putting files in the Wastebasket does not a utomatically delete them, they are simply 
removed from their original position. To delete them altogether, you need to use the 
Empty Wastebasket facility on the Special menu (see the section o n this below). This 
means that if you change your mind about gett ing rid of a file you have the opportunity 
to retrieve it. 

Renaming files and folders 

There are several reasons why you might want to change the name of a file or folder. If 
you have made a copy o f a file using the Duplicate command it will be called 'Copy of 
File' and you wi ll probably want to give it a new name. Sometimes you find that the 
original name you gave to a file does not adeq uately reflect its contents . Presumably 
you wouldn't want to change the contents to fit the name so the simplest route is to give 
it a new name. 

To alter the name you must first select the file, folder or disk whose name you want to 

change. Put the arrow on the actual name and it will cha nge sha pe when correctly 
positioned. Don't do anything else with the mouse - switch to using the keyboard. As 
soon as you press a key the original name will disappear a nd you can type whatever 
name you choose into the blank space. That name will become the new name attached 

7 
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to the icon. You change the name of a ny of the icons in this way and it in no way affects 
the way they work. Macintosh immediately identifies them by their new name. 

Before getting my Macintosh I had always used keyboard operated computers. It took 
me a little while to get used to the mouse and especially to the idea that once you picked 
it up it no longer functioned. This got easier after a short time and I found that I only 
needed a small space on which to move it. 

The main advantage I find with usi ng the mouse and icons is that you can always see 
exactly what you are doing. You are less likely to make mistakes than with conven­
tional command-driven machines, where an incorrect command can result in an 
obscure message such as' Attempted write-protect violation'. ln contrast, on the Mac­
intosh you can see what you have done wrong - the fi le that you thought you had 
deleted is still there; you have selected the wrong disk to work with. This can save you 
time that is often wasted trying to figure out what the computer is trying to tell you. 

Disks 

When l received my Macintosh it came with two copies of the system disk and the 
Write/Paint disk, a guided tour of each and a spare disk . I put one copy of the System 
Disk and Write/ Paint away safely so that if I should have any problems I would have 
a spare uncorrupted copy to work with. 

The system disk contains a ll the files you need to run the operating system, which is 
described in the next section. If you insert this disk and open the system folder, you will 
see a number of fi les represented by Macintosh icons. This tells you that they are 
system files. They control the machine's operation. l fyou try to open one of these files 
you wi ll be told' An application can't be found to open this file ' - in other words you 
can't look at the contems of the file. 

The Write/Paint disk contains the two programs MacWrite and MacPaim and the 
contents of the system disk- the system folder and the font mover. The two programs 
cannot run without the system files which control the various loading, opening and 
closing operations. 

Both the system disk and Write/ Paint are what are described as startup disks and as 
such cannot be erased- a message will appear to this effect if you try to do so. This is 
to protect them against accidental erasure. You can do this to any of your disks by 
'locking' them; that is pushing the small red notch on the disk towards the edge of the 
disk. Locking the disk will allow you to use what it has on it but will not let you make 
any changes to it or add more files . 
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Finder- Macintosh's operating system 

The operating system of any computer is the set of programs which controls the file­
handling operations. It will also provide what are described as system utilities. 

In the case of the Macintosh the operating system is called Finder. You have already 
seen how to open, close, move and delete files using the mouse. All the activities of the 
mouse are controlled by Finder. The mouse is your way of communicating with 
Finder. 

As well as using the mouse itself to carry out certain tasks, Finder also operates via a 
series of menus, which are stored under the names and icon which appear at the very 
top of the screen. 

The menus 

In this section I shall look at the menus and discuss the various facilities which Finder 
offers. The menus are stored under the headings at the top left of the screen. To see 
what the menus contain you must position the mouse on the title of the menu you want 
to see and drag it downwards to reveal the menu contents. As you move the mouse 
down, each currently available option will be highlighted. 

Some of the options will appear in slightly fainter print. This means that those options 
are not available at that particular time. (See Figure 1.6). 

I am going to look at each of the menus in turn to see what options each offers. For the 
moment I shall leave the Apple icon out since it contains the system utilities I men­
tioned earlier. I shall deal with this last and begin by looking at the File menu. 

Handling files- the File menu 

Using Finder is a combination of mouse and menus. In some cases, the same oper­
ations can be performed either by using the menu or, as a shortcut, by the mouse on its 
own. On the File menu you will see options for opening and closing files, which can 
also be carried out by using the mouse in the way described in the preceding section. 

Other options may only be accessed via the menus. In any case I shall be taking each 
option in turn and seeing how it works. As you get familiar with the machine you will 
probably develop your own preferences for using the menu facilities and the shortcuts. 

9 
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Figure 1.6: Menu Options 

In the section on the mouse, l talked about using double-clicking as a means of opening 
fi les. An alternative is to select the file to be opened by cl icking on the icon, then 
moving to the File menu and highlighting the option Open . There is no difference 
between these two act ions except that double-clicking is marginally quicker tha n using 
the menu . H owever, once you get used to using the mo use you will find that you can 
move around very q uickly and the time it takes is minimal. 

Duplicate 

When you first look at the File menu 'Duplicate' will not be highlighted . Before you 
can duplicate a fi le, Finder needs to know which o ne you want to duplicate. You must 
fir st select it, then make a copy by choosing the duplicate option. The duplicate will be 
la belled 'Copy of File'. The same method can be applied to creating new folders so you 
can keep different types of files in d ifferent folders. In Figure 1. 7 I have illustrated the 
duplicate command by making two copies o f the empty fo lder. As I mentioned earlier , 
it is a good idea to rename the folders once you have copied them so that it re flects what 
they are to contain . 
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Figure 1.7: Copying Folders 

Gerlnjo 

This option from the File menu gives you in formation about the disk, fo lder or file that 
you have selected - its size, when it was created, thedateofthe last modi fication and a 
sumary of what it conta ins. For files you create, Get Info will allow you to put in your 
own summa ry of the file' s contents. It can be q uite useful as a way of checking what a 
file contains and saves opening it unnecessarily. Figure 1.8 shows you what in forma­
tion is kept on the system folder. 

Pur Back 

Put Back will replace files in their original posit ions. Imagine that you had decided to 
delete a file. You put it in the Wastebasket. Then you change your mind. To replace the 
fil e in its original folder, yo u would choose the option Put Back. 

Close and Close A ll 

If you are looking at one particular fi le you can close j ust that one, or an entire folder 
or even the disk window. T his reproduces the action of the clicking the mouse on the 

II 
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~0 lnformotion about System Folder 

System Folder 0 
Kind: folder 

Size: contents totol217088 bytes 

Where: System Disk, internol driue 

Created: Tue, Jonuory 24, 1984 at 10:08 

Modified: Sun, March 1 1, 1984 at 1 1:54 

0 locked 

!Open this folder to see the documents used by the 
Macintosh. 

Figure 1.8: Get Info 

square at the top of the window. I find that I tend to use the square at the top of the 
window as a quicker method of closing files tha n moving back to the menu. 

Eject 

When you choose this option, the disk will be ejected from the drive. If you have only 
one disk drive you will find that you may need to use eject quite often to copy files to or 
retrieve them from different disks. 

When you have ejected a disk, its icon will still appear on the Desktop but the icon will 
assume a lighter pattern to indicate that it is not currently accessible. You can even try 
to open the disk, but if you try to use any of the files Macintosh will automatically eject 
the current disk and ask you to insert the original. 

Edit Menu 

The chief functions of the Edit menu are to allow you to copy, delete or move parts of 
files which you have opened. It is not possible to do this with system files, because they 
are 'locked' so that you cannot interfere with them. However Cut, Paste and Copy 
features can be very use ful when you are creating your own MacPaint and Mac Write 
files. I sha11 be showing you in some detail how they work in Chapter 2. 

View menu 

The View menu offers you several options- by icon, name, date, size or kind . View 
can only be used if you a lready have a window containing files and folders open. T he 
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normal method of looking at the files is by icon. However, if you choose one of the 
other options, the name and details of the files will be displayed as text. 

Viewing by name, date, size or kind gives you full details about the files and in the 
order which you specify- for example if you choose by name, the files will be dis­
played in ascending alphabetical order according to the name of the file. To show that 
you have chosen to sec the files in name order, the heading of the name column will be 
underlined as you will see in Figure 1.9. 

:;[J ~ystem full:ler 

Size Home Kind lost Modified 

I 1K Clipboard FiiP S':J!.tt-rti docurntnt v~o, rtb 29, 1984 

r ' 
I 46~ finde r ~ystHo .jc,<,urne-nt Tu•.Mor 6. 1924 

I 17K lmag~"'rit~r 5y st~rn docurnt?nt Tu~. J~r. 24 . 1984 

I 21: Hot~ Pod Fil~ S..J stern do-.:-urr.ffit W•d,O.< 12, 1984 

I - K Scrapbook rilt :;.~ : t€'m d(oC.IJh'\i"r,t w'•d . .Jon ' 8. 1984 I 

14~1{ I 
S~sttm Slj!lern doc~ro\ Thu. Au9 23, 19<14 

10 
<~I 10 12J 

Figure 1.9: Files displayed by Name 

The size of the window in which the details are displayed is designed to show the icons 
but this is not large enough to display all the details. In order to see the full details you 
must enlarge the window by placing the arrow on the bottom righthand corner of the 
window and, with your finger on the mouse pad, pull the window right and down.First 
of all, a dotted outline of the window will move to the position you stop at. Then when 
you release the pad, the enlarged window will appear and all the details will be visible. 

Special menu 

The three options listed here a re Clean Up, Empty Wastebasket and Erase Disk. Clean 
Up is used when you are viewing the fi les by icon. It will rearrange the icons neatly in 
rows if you have moved any of them or made copies. 

Empty Wastebasket. will delete the contents of the Wastebasket. this option is only 
avai lable if there is actually anything in the Wastebasket. When you a re going to empty 
it, it is probably safest to have a look at what is in the Wastebasket beforehand- just 
in case you have put something in there by mistake. To see what is in the Wastebasket 
you need to open it by double-clicking on the icon. 

Erase Disk wi ll delete the entire contents of a disk, so you have to be sure you want to 

gel rid of everything before you use it. If you try to erase a system or program disk you 

13 
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will be told 'This is a startup disk; it cannot be erased'. My Macintosh manual made no 
mention of this facility but it can be very useful for clearing out old files and reusing the 
disks for other purposes . 

System utilities- the Apple menu 

T he Apple menu contains what I have described above as system utilit ies. These utili­
ties are additional features which are not necessarily vital to the operation of the 
machine but are enhancements to its functioning. 

The Apple menu stores these utilities and contains this list of options: 

About the Finder ... 
Scrapbook 
A la rm Clock 
Note Pad 
Calculator 
Key Caps 
Control Panel 
Puzzle 

Each of these options works independently, that is to say, it is not directly connected to 
any one file or disk-handling procedure, unlike the other menus. Most of the options 
on the menu can be used in Mac Write and MacPaint and their facilit ies can be incorpo­
rated into particular files. I shall be showing you how you can use them in this way in 
chapter 4. In this section, however, I am going to limit the description of each to its 
basic function. You can see most of the Apple menu facilities in Figure 1.10. 

Aboutthe Finder . .. 

Selecting this option will tell you what version of the Macintosh Finder you are using 
and the date it was introduced. Both Mac Write and MacPaint contain a similar option 
which gives details of those two programs, their authors and date of creation , etc. 
Unlike the other options, About the Finder ... will close automatically when you go 
on to another option. 

Scrapbook 

Scrapbook is used with the two packages Macpaint and Macwrite, for storing pictures 
or text that you want to use more than once, or to move from one document to 
another. You cannot look at what it contains unless you are using one of the two 
packages. 
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'" • File Edit Uiew 
., 

Keep up to eight pages of notes 
in the Note Pad. Click on the 
dog -ear to turn to the next 
following page. Click in the 
lower left corner to turn to the 
next previous page 

Figure 1.10: Apple Functions 

Once you enter either MacPaint or Macwrite you will discover that Scrapbook already 
has some sample information in it- a picture of a fish (see Figure 1.11) and a robot as 
well as some items of text. 

Adding pictures a nd text to it involves using the Cut and Paste options on the Edit 
menu and I shall be looking at how to do this in Chapter 4. 

A larm Clock 

The Macintosh has a battery-operated clock and date fu nction . Normally, only the 
current time will be displayed when you activate the Alarm Clock option. However , by 
positioning the mouse over the small key in the righthand corner of the clock box and 
pressing the pad, you can see the date and three further boxes. The first two are for 
displaying either the time or the date, which you can then modify. The third box 
contains a picture of an alarm clock. If you choose this option, another time will 
appear in the middle box and this is the time a t which the alarm is set to go off. To the 
right of the middle box is a smaller box with aT shape in it. If theTis upside down, the 
alarm is off, otherwise the bell will sound a t the time indicated. As with the date and 
time, you can alter the alarm time. 
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Scrapbook 

! 2 of2 PICT 

Figure 1.11: Scrapbook Picture 

I have mentioned the alarm clock feature in detail since it is not included in the manual 
I received with my machine. 

NotePad 

As it explains on the first page of the Note Pad, you can store up to eight pages of notes 
on the pad and you can turn the pages by clicking on the dog-eared edge of the paper. I 
have not personaJly found any use for this utility yet but I imagine it could be handy if 
you wanted to use it as a place to store messages to yourself. 

Calculator 

A basic calculator designed to look exactly like a real one with the ability to add, 
multiply, subtract and divide. The results of calculations can be extracted and put into 
other documents. I show how to use the calculator in this way in Chapter 4 to design an 
invoice. 

Key Caps 

This utility reproduces the Macintosh keyboard and shows you what pressing the 
various keys on it will do . For example if you press the Shift key on the ordinary 



INTRODUCTION TO THE MACINTOSH 

keyboard, all the letters on the Key Caps keyboard will change to capitals and the key 
you are pressing will be highlighted on the Key Caps keyboard . It will also reveal the 
special characters which Macintosh provides for writing foreign languages and using 
mathematical symbols. These are accessible by pressing the Option key. See Chapter 4 
for an example of how to use them. 

Control Panel 

T his panel controls a number of the features of the machine 

The loudness of the bell tone 
T he pressure required to get a double click from the mouse 
T he speed at which the mo use moves 
T he speed at which the insertion point line blinks 
The pressure required to get a response from the keyboard 
The background pattern for the Desktop 
The date and time can be adjusted 

None of these features is particularly vita l, but having the ability to adjust them shows 
a lot of consideration for the user's comfort and gives you added control of the oper­
a tion of the machine. 

Puzzle 

This is one of those number puzzles where you have to move the squa res around unti l 
you get them in the right order. As the Macintosh manual points out , the main frust­
ration with this is that you can't cheat by pulling out the squares and rearranging them 
yourself. 

If you went through the guided tour of the system disk you probably discovered the 
mazes which come on the disk . I found these were fun to play with and got me used to 
movi ng the mouse around the screen with accuracy. 

Shortcuts 

As an alternative to using the mouse and the menus, Macintosh also offers you a 
number o f shortcuts which are to be found on the keyboa rd itself. You will probably 
have noticed on the menus that beside some oft he options is the Command key symbol 
and a letter. If you press this combination of keys on the Macintosh keyboard, Finder 
wi ll duplicate the action on the correspo nding menu option. For example, on the File 
menu beside the option Duplicate is the Command symbol and the letter D. Instead of 
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duplicating via the menu, use the Command D key combination. You will find the 
result will be the same. 

Conclusion 

I have used this chapter to outli ne all the basics of Macintosh and its operating system. 
Finder is vital to the functioning of the other software you use on the machine. It acts 
as the machine controller (on larger machines, the word 'housekeeping' is often 
applied to the jobs it does). Finder enables you to carry out aU the basic operations of 
opening and closing files, or copying and deleting them. It will produce messages to tell 
when you have done something wrong or if you have no space left on your disk. You 
cannot do much with Finder itself but without it you cannot use the other software. 

By using the mouse and icons, Macintosh gets over the problem that you often encoun­
ter with machines where you issue commands to the operating system by means of the 
keyboard - having to remember the exact spelling and wording of the command 
before you can get a response. All you need to remember with the Macintosh is how to 
move the mouse and how to use its pad . 

Now you have seen all the basics of how Macintosh works you are ready to find out 
about Mac Write and MacPaint. 



CHAPTER2 

Introduction to Mac Write 

MacWrite is a word processing package which, in common with many such packages, 
gives you the a bility to produce a variety of documents -letters, reports, memos and 
so forth. It has a range of editing facil ities which enable you to move text, make copies 
of it , delete it, scan through it to find words and phrases and change them. In fact, 
most of the faci lities you might expect from any good word processing package. I am 
going to devote this chapter to telling you how to use these standard features in 
Mac Write. 

You may have guessed, however, that this is not the whole story. In addition the 
standard faci lities, Mac Write has some rather extra-ordinary ones. These include 

Five different sizes of lettering 

Nine different fonts each one available in the five sizes 

Six style features 

You can introduce pictures into the text from MacPaint 

Foreign characters and other symbols are readily available 

Calculations can be inserted in the text 

I sha ll be covering these later. I a m going to start with a description of the screen 
layout. 
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The Mac Write screen 

Opening the Mac Write file is rather similar to opening the other windows as we did in 
the Chapter 1. The main difference is that, once opened, the window fills the whole 
screen. Across the top is the fami liar window heading with the name of the file- in 
this case it is untitled- you won't have given your file a name yet. (See Figure 2.1 for 
the Mac Write screen layout.) 

,. • File Edit Search Format Font Style 

Untitled 

: -~··L• .. L .......... J ? ........... .L •... I ...•• J3,_.1 ...•. . L •.. .~-. •. ..1~ ......... .1 ·• . ...... .1.5, ._, ··•·,!;·· ·!. .•. .! ~ •... 1. ·•·· L. •... L. • . f;f! 
..,_;~=...;;;;~~-.....;1=~=1-=1 =-=11=1 __ -=1~=-=11 =- =-1 =I ='-=' =-~' 1 

r 

Figure 2.1: The MacWrite Screen 

You can treat the Mac Write window as you would the Finder windows. If you put the 
cursor on the top line and drag the mouse in any direction the window will move, 
revealing the Desktop background behind it. If you move the window to the left, you 
will reveal the two small sq uares at the bottom r ight of the screen which a llow you to 
make the window larger. By dragging them outwards you can see the right edge of the 
MacWrite Ruler which, in fact, stretches to the 8" mark which is normally hidden. 

As with Finder, there are a number of menu options at the top of the screen. In addi­
tion to the Apple icon, there are menus entitled File, Edit, Search, Format, Font and 
Style. In this chapter, I am going to concentrate on the File and Edit menus. I shall also 
be talking about the features provided on the Ruler which appears just beneath the 
window heading. I am going to show you how to create documents which will use all 
the features available on the two menus and the Ruler. 
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The Ruler itself contains a number of icons all of which represent different functions . 
The top line, which is divided into inches and fractions of an inch, allows you to set up 
the tab and margin positions. Beneath it are the various symbols which , working from 
left to right, represent the tab and decimal tab markers, three types of line spacing and 
four types of text justification- right, centre, left and both right and left (See Figure 
2.3further on in this chapter). I'll be looking at each of these in detail later. 

Underneath the ruler is the main area where you will type in text. There is a cursor to 
mark your position on the screen. It takes the form of a straight vertical line. This is not 
to be confused with the mouse arrow which moves independently of the editing cursor. 
You' ll see that when the arrow is on the MacWrite screen, it takes the shape of what 
Apple call an 1-beam. As you will see, the I-beam lets you reposition the entry point for 
text. 

On the righthand edge of the window is the strip with arrows at both ends which 
enables you to scroll through documents which extend over more than one screen just 
as you did with the Finder windows. The documents themselves are actually divided 
into pages of 44lines each . 

That is the basic layout of the screen . It is consistent with the form a lready seen with 
the System disk. Most of the features are displayed on the screen and are immediately 
accessible. Others are stored in pull-down menus. Once you are familiar with using the 
mouse, accessing the various options is easy. I am not going to spend much time 
discussing that in this chapter. I am going to concentrate instead on how to use the 
available options to good effect. 

Typing in text 

Example- An announcement to customers 

Up to now all the manipulation has been done by the mouse and you have hardly 
touched the keyboard. Now is the time to practise your typing skills. I have typed in a 
short letter (Figure 2.2) to act as an illustration to the basic features I shall be discussing 
in this section. 

The Macintosh keyboard has the layout of a standard typewriter . I have assumed that 
you are familiar with this type of keyboard and with keys like Tab and Shift. If you 
have never used one before, the best thing for you to do is to take a look at the Key Caps 
option on the Apple menu, which will show you what effect pressing the different keys 
will have. Alternatively, you can simply experiment for yourself - figure 1.2 in 
chapter I shows to the positioning of keys and what each one does. 

21 



MASTER YOUR MACINTOSH SOFTWARE 

22 

Announcement to Customers 

Dear Customer, 

Brooks Disks have long been a major distributor of all tbe best makes of 
floppy disks for all types of microcomputers. We are now pleased to 
announce Brooks have now developed tbeir own remarkable new floppy 
disks witb lOOOk of storage space on each side. UnW tbe end of tbe 
month tbese amazing new disks will be on offer to our existing customers 
at tbe spectal price of £30 per box of ten•. Don't miss this fantastic offer! 

Best regards, 

Brooks Sales Manager. 

• On orders of 5 boxes or more. 

Figure 2.2: Announcement to Customers 

When you are typing, you don't need to worry about pressing the carriage return at the 
end of the line, because the cursor will automatically move to the beginning of the next 
line. The only time you need the carriage return is if you haven' t typed a full line and 
you want to start a new paragraph. 

T he speed at which a key repeats (that is , if you hold your finger down on it) and the 
pressure needed on the keys are adjustable on the Macintosh, so if you find that you 
tend to be rather heavy-handed or alternatively not heavy-handed enough, you can 
alter the pressure . This feature appears on the Control Panel option of the Apple menu 
and you can experiment with it until you find the pressure which suits you best. 

If you want to practise the use of Mac Write's various features, you should type in the 
text as it appears in Figure 2.2 before going on to the next section. Don't worry too 
much about any mistakes at this stage, because I shall be talking about how to make 
corrections and alterations later on. 

Moving the cursor 

With conventional keyboard-operated computers, when you want to move to differ­
ent points in a word processing document, you use four arrow keys which move the 
cursor up, down, right and left along the lines on the screen. The four arrows will also 
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combine with other keys so that you can move word by word, line by line, paragraph 
by paragraph, and so on . Each of these combinations has to be memorised. On one 
word processor I have used, there were no fewer than eleven keys involved in moving 
the cursor around (though not all at once, thank goodness). 

In MacWrite, you can move and reposition the cursor anywhere you want within an 
a lready created document by means of the mouse. When the arrow is in the main 
MacWrite window it changes to a shape called an !-beam which will move around as 
you move the mouse. If you click the mouse the cursor will be repositioned where the 
!-beam is. You will find, however, that if you have just started with a blank screen, any 
effort to reposition the cursor by using the mouse will not work. This is because the 
screen is not accessible unless it has been typed on (even if this is only by pressing the 
carriage return a few times). 

Selecting text 

Once you have typed in several lines or paragraphs of text, it often happens that you 
change your mind over wording, or the order of paragraphs, and you decide that you 
want to alter something. The Edit menu provides a number of options which you can 
use to manipulate your text. However, before you can use any of the editing features 
you must have selected the section of text you want to alter. Here are the various ways 
of selecting text 

Word: Move the mouse to the beginning of the word and double-click. As 
well as selecting the word, this will also allow you to replace it. 
Having double-clicked on the word, if you now try to type at the same 
position, you will find that the selected word will disappear allowing 
you to type in something new. Should you change your mind about 
the alteration, the Edit menu will allow you to 'Undo Typing' and 
this will restore the original word. This feature applies to any length 
of highlighted text. 

line: To select a line or several lines, put the mouse at the beginning of the 
line and drag it up or down. This method will highlight as many lines 
as you choose but you need to be fairly accurate about how you posi­
tion the mouse as, if you are not careful, it will sometimes highlight 
lines you don' t want to select. Dragging the mouse is also effective 
for selecting a few words on a line. 

Specific length: If you want to highlight a specific area of text- a sentence or para­
graph or number of lines, then you can do so by positioning the 
mouse at the beginning of the text and clicking. Move the mouse to 
the end of the text and press the Shift key on the keyboard whilst 
clicking on the mouse. This will highlight all the text between the two 
points. 
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After you have selected your text, if you click the mouse in any other position on the 
screen you will have cancelled your previous selection. Once you have selected your 
piece of text, you can then make use of the Edit menu to carry out the changes you 
want. 

Edit menu 

When you pull down the Edit menu you wi ll see five different opt ions- Can't Undo, 
Cut, Copy, Paste and Show Clipboard. Remember, these actions will only apply to the 
piece of text you have already selected. If there is no text selected, the options appear in 
fainter print to indicate that you cannot use them. Here is what the options can do . If 
you want to try them, select the last sentence of the letter which starts 'And there 
are ... '. 

Cut and Undo Cut 

Move the mouse to the Cut option and release the pad. The marked text will disappear. 
Now go back to the Edit menu. Where before the top option said 'Can't Undo', it now 
says 'Undo Cut'. It is giving you the opportunity to change your mind. Choose that 
option and the highlighted text will reappear. If you go back to the menu again, you' ll 
find that the top line now say 'Redo Cut'. I find this really does duplicate my thought 
processes quite often. I have decided to delete something, I delete it, then I think 'Was 
that the bit I wanted to delete? ', I can call it back- 'Ah yes, that's it ' and then I can 
delete it again. Even then, it is not actually deleted but stored in the Clipboard. We'll 
have a look at that in a moment. 

Copy and Paste 

Having cut and uncut a section of text, you will see that it is still highl ighted. Instead of 
deleting the text this time, make a copy of it. Choose the Copy option from the menu. 
Once you have made a copy o f the selected text, switch off the highlighting by clicking 
the mouse with the 1-beam elsewhere on the screen. Now return to the Edit menu. The 
only options now in dark print will be Show Clipboard and Paste. If you choose Paste, 
a copy of the text will appear wherever the cursor is currently positioned. I fthe original 
text is still highlighted, the copy will be superimposed on it. 

As with Cut and Copy, pasting will offer you the further option of undoing or redoing 
the paste action . Pasting can be useful particularly if you have a word or phrase that 
you want to repeat again and again. Such a feature would have been invaluable to me 
at university where I was writing papers on such people as Preobrazhensky and 
Nadezhda Krupskaya. 
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Show Clipboard 

The C lipboard is the area in memory that the Macintosh uses to store the results of Cut 
and Copy commands. If you want to see what you last cut or copied you can look at it 
by using Show Clipboard. Although the Clipboard which you see on the screen is quite 
small , you are not restricted only to using it for small pieces of text. Just as with the 
other windows, it can be expanded and its contents can be considerably larger than 
those which are actually visible. 

To remove the clipboard from the screen you can use the option Hide Clipboard. Each 
time that you cut or copy a new piece of text, the contents of the Clipboard are over­
written. This means you can only ever store one piece of text in it at a time. A more 
permanent way of storing information is in the Scrapbook which we will be looking at 
further on. 

Shortcuts 

Just as with the Finder menus, those in MacWrite also have alternative shortcuts for 
various facilities. On the Edit menu they are the same as in Finder- a combination of 
the Command key and a letter key to cut, copy, paste or undo an action. You will see 
which options have shortcuts- it is those which have the Command symbol with a 
letter beside it. 

T he Edit menu has quite a small range of options - in fact, it only has three real 
actions - Cut, Copy and Paste - each of which can also be undone. However, you 
can select any section of text you choose (from a single character to an entire docu­
ment) which you can then manipulate as you like. This means that although the 
selection of editing options is quite small , you have a great deal of flexibility as to the 
range of text you can use them on. You will also find that Cut, Copy and Paste are used 
extensively not just in MacWrite, but also in MacPaint, and that they are invaluable 
for making use of the Scrapbook feature. 

File menu 

New , Open, Close, Save, Save As ... , Page Setup, Print. .. and Quit are the options 
available on the File menu. Most of these are the basic fi le-handling operations which I 
discussed in Chapter I. They are controlled by Finder, but when you are using Mac­
Write, it is much more convenient to have them readily available in MacWrite itself 
rather than have to exit before opening or closing files. You will find , however, that the 
same file operations can be carried out without having first to open Mac Write. If you 
try the same options on the Finder menu, Macwrite (or MacPaint) will automatically 
be loaded for you and a particular file, opened or printed or whatever. In this section I 

25 



MASTER YOUR MACINTOSH SOFTWARE 

26 

am going to look at the options on the Mac Write File menu. I shall continue to use the 
example in Figure 2.2. 

Print ... 

When you want to print something from Mac Write you have a number of choices to 
make- what quality print you want, whether to print part of the document or all of it, 
how many copies you want to make and whether or not you are using single sheet or 
continuous stationery. (See Figure 2.3) Here is a summary of what each of the options 
does 

Quali t y: OK 
Page Range: 

0 High 

(!) All 

C~ St andar d 0 Draft 

0 From: D To: D 
Copies: 

Paper Feed: 

Quali ty 

Page Range 

Paper Feed 

D 
@ Continuous 0 Cut Shee t ( Cancel ) 

Figure 2.3: Print Options 

High: T his is the slowest o f the three qua lity options but in return 
offers the best appearance to the printed text because the print head 
makes a double pass over each row thus producing a darker print. 
Standard: One pass is made of the line and, providing that your 
ribbon is in reasonable condition, it wi ll give a presentable printout 
of your document. 
Draft: This is for doing a quick printout of your document which is 
in a standa rd font and size . lt does not take account of any changes 
you may have made to style or fo nt. (F igure 2.4 gives an example o f 
each of the different qualities.) 

You can either print an entire document or you can specify a range of 
pages that you want to print. 
The two options available here take account of whether you are using 
single sheets of paper or continuous computer printout paper. 

For the moment, just accept the default settings, Q uality- standard, Page Range­
all , Copies - I , Paper Feed - continuous (unless, of course, you are using single 
sheets of paper) . 

When you are ready, you can go ahead and print. MacWrite will tell you that it is 
saving a copy of the printed document to disk. This can take several seconds, so don't 
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This is a sample of high -quality printing 

This is a sampl~ of standard-quality printing 

This i s a samplP of draft-qual i \y pr i nting 

Figure 2.4: Print Qualities 

worry if the printing doesn' t start immediately. Once the printing starts , MacWrite 
will tell you that if you want to stop you must press the Command key in conjunction 
with a full stop. 

If the printer is not switched on when you go to print, MacWrite will act as though it 
was and give the same message and then revert back to normal working. If the printer is 
on but will not print, Mac Write will give the message 'The Printer is not responding. 
Check the cable, printer switchs (sic) etc. ' It then gives you the chance to check the 
printer and continue or to cancel the printing. In the second case it tells you 'This 
document can't be printed'. 

Page Setup 

To print out the small document which I have used as an example, I needed only the 
normal print settings. For larger documents there is an additional set of options to be 
found under the Page Setup feature . These consist of the paper options which allow 
you to change the width and length of the paper you are using and the orientation 
options which give you three ways to print your document - Tall (normal printing), 
Tall Adjusted (normal printing but with pictures correctly proportioned) and Wide 
(printing sideways on the paper for extra wide documents). 

Close and Save 

The letter you typed does not have a name at the moment. In order to close the file and 
save it on disk you must give it a name. (The close and save process can be done 
together). Choose the Close option from the File menu. Unless you have already saved 
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the file and have not made any changes to it since, Macintosh will respond by giving 
two short beeps and a window will appear asking you 'Save changes before closing?' 
and giving you three options- ' Yes', 'No' or 'Cancel'. Say 'Yes' and another window 
will appear. 

Within this window are several options. You will also see a cursor in a box marked 
'Save current document as'. Mac Write is asking you to give your untitled document a 
name. Type in any name you like. 

I have found that much time and effort can be saved by making the name reflect the 
contents of the files as closely as possible. I called my file 'letters'. Now click on the 
Save box and after a few seconds you will be returned to an empty screen with the menu 
names at the top. (Remember that you have already opted to close the file). 

If you want to store information about what your files or folders contain you can use 
the Finder option Get Info to write a brief file dscription so that you can identify what 
is in them. This can also be helpful if someone else is going to be using the files who is 
not familiar with what is in them. It can really save time particularly if you have been 
keeping your Mac Write document files on another disk. 

I have found the Macintosh to be a very reliable machine, but it is not a good idea to 
rely on it totally- a power cut can wreak havoc with your data. It is therefore advisa­
ble to save your files quite often- once every half hour is probably safest. It is a good 
habit to get into, and saving the fil e doesn't necessitate actually closing it. Mac Write 
will save the file and then let you resume your editing. If you save quite frequently, a 
power cut or any other disaster will mean that you only lose a small amount of work 
which can quickly be redone. 

Save to another disk 

As the number of files you create increases, you will find that there is not enough space 
on one disk to accommodate them and all the system files you need to run MacPaint 
and Mac Write. Something like 350k of the space of the Write/Paint disk is taken up 
with system files and fairly soon after you start saving files on that disk you will start 
getting the message 'Disk is full'. This means you will have to start saving your files to a 
separate disk. 

When you opt to save your fi le, you will see on the left of the Save box is an option 
which says Eject. This is to allow you to change disks before saving the file. Don't 
worry about how you are going to return to the original disk, Mac Write deals with a ll 
the disk swapping by a series of dialogue boxes telling you which disk it wants you to 
insert at any moment. 
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Saving to a new disk 

If you are going to save a file to a new disk, that disk will have to be initialised before 
a nything can be saved to it. Choose the Save option as normal and eject the Write­
/ Paint disk. When you put in the new disk, Mac Write will tell you that the disk is not 
initialised. It will ask you to confirm that you want to initialise it, and will ask you to 
give the new disk a name. A message will appear telling you that the disk is being 
initialised. When the process has finished , the file will be saved to the new disk. 

Save As ... 

It is often the case when you a re setting up files that you will want to save more than one 
version of a file. In this case you need to use Save As ... which gives you the option of 
saving a n already existing file under a different name. 

If you try to save a file using a name which has alredy been attributed to another file, 
Mac Write will ask you if you want to replace the existing file, and will allow you to go 
back and alter the name. 

Quit 

When you have finished working with Mac Write, selecting Quit will return you to the 
Desktop display. You don ' t have to close your files when you opt to quit, because the 
Macintosh will give you the same options as it gives with Close. It will ask you if you 
want to save the changes you have made. 

New and Open . .. 

When you have closed your file, access the F ile menu once again and you will see that 
the first two choices are highlighted- New a nd Open. This is Mac Write offering you 
the option to open an existing file or create a new one. Choosing Open will give you a 
list o f the existing files and you can then select the one you want to work on. In our case 
though, we are going to start with a clean slate, so select the New option. I shall move 
on to the Ruler and its associated icons. 

The ruler 

Earlier in this chapter I briefly described the ruler functions. In this section I a m going 
to talk about these and provide practical examples of ways using each o f them . Figure 
2.5 shows the Ruler and the different features it contains and you should refer to it as 
you work through the examples. 
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RULER 
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Figure 2.5: The Ruler facilities 
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Brooks' promotion of their new disks has been quite a success, but Mr Robinson of 
Robinson Computer Services is none too pleased with their product and has registered 
his complaints in a letter. In the cause of good relations, Brooks has sent him a court­
eous letter in reply. I have used their reply to talk about some of the features of the 
ruler. Figure 2.6 shows Brooks' reply. 

Just beneath the actual ruler markings themselves you will see three small symbols. 
The leftmost one resembles a black paper aeropla ne, the middle one is a white t ria ngle 
and the third is a black triangle. I shall talk about the middle one later but for now I 
shall concentrate on the other two, si nce they are the margin markers. If you want w 
see how to cha nge the margins, begin by typing in the letter shown in Figure 2.6 with 
the normal settings in place. You can change them afterwards. 

Indent 

The margins a re set by manipulating the markers on the ruler. The lefthand symbol is 
in fact two markers, one overlaying the other. One is the lefthand margin and the other 
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C.T. Robinson, 
Robinson Computer Services 
Hartley Road 
Cranley Green 

Dear Mr Robinson, 

24/9/84 

I was very sorry to hear that the disks you received appeared to be faulty. 
We have had a terrific response to our new disks and yours is tlle only 
problem we have encountered with tllem. We would like you to return the 
disks to us and we will eitller replace them or refund your money, 
whichever you would prefer. 

Thank you for your letter, we always like to receive comments from our 
customers. 

Your sincerely 

Brooks Sales Manager. 

Figure 2.6: Company's Reply 

is an indent margin. Position the arrow on the symbol and drag it to the 1.5" mark. 
When you release the mouse pad you will find that only one of the icons has moved and 
the triangle has remained at the original point. You will also see that part of the text has 
moved as well. What has happened is that the Indent Margin has been moved. This 
margin is only activated when you press the carriage return key. MacWrite takes that 
to mean that you want to start a new paragraph and so allows you to indent the text. 

Left 

The lefthand margin position is marked by the black triangle. If you drag it right along 
the ruler, the left edge of the text will be repositioned at the new point. 

Right 

You can reset the righthand margin by dragging the triangle on the right either to the 
left or right along the ruler. The right hand edge of the text will be readjusted according 
to the positioning of the margin markers. To reproduce the style of the Brooks letter, I 
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positioned the markers at 2.5'' (left margin), 2. 75" (indent margin) and 6" (right 
margin). 

Tabs 

In order to illustrate how the Tabs work on the Macintosh, I am going to use the 
example of a list of the names and phone numbers of Brooks' distribution centres. The 
list is shown in Figure 2. 7. 

Distribution centre Manager Phone No. 

Alderham David Marshall 0982 7780 
Bishopston Barbara Howard 0342 9523 
Cranley Brian Jenkins 06792 437 1 
Fernton Gr~n Fred Briggs 0345 31920 
Hartley Graeme Patterson 0495 7395 
Langton Biswell Mohammed Share! 0345 8932 

Figure 2. 7: Distribution Centre P hone Numbers 

If you are not familiar with Tabs or tabulation , it is a method of setting markers in a 
document so that the text can be arranged in columns down the page. It is mostly used 
for lists. In Mac Write you can have as many tab markers as you like within the limit of 
the space available on the ruler. 

At the 5.5" mark on the ruler is a small white triangle . This is a tab setting. As with the 
margin settings, it can be repositioned by dragging it along the ruler. Although only 
one tab setting is given when you start using Mac Write you can add others by using the 
tab icon which lies at the lefthandend of the ruler . It is the box with the white t riangle in 
it. 

In order to set up the list I needed two tabs so that I could put the information into 
columns. The list conta ins three columns - one for the name of the distribution 
centre, one for the manager and one for the phone number. 

There was no need to put a tab for the first column since the margin setting marked the 
edge of the page. You do not need to adj ust the indent margin since you want the text to 
be at the edge of the page . I left the original tab setting at the 5" mark and put a new one 
at the 3" mark. To do this you need to put the ar row on the tab icon and drag it to the 
point on the ruler where you want it positioned. T hen release the mouse pad. If you go 
back to the keyboard and press the tab key (the key marked with the arrow pointing at 
a short vertical line) you will find that the cursor will jump to the position marked by 
the tab triangle . 
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If you want to remove a tab, place the arrow on it and drag it downwards away from 
the ruler. As soon as you release the mouse, the tab will disappear. 

Decimal Tabs 

Brooks has decided to put its price list onto the computer so that making changes to it 
wi ll not involve typing the whole thing out each time any of the prices change. Figure 
2.8 is a copy of the list. 

DISK 

Brooks S/S 
Brooks D/S 
Brooks Superdisk 

Microtex S/S 
Microtex D/S 

Compudisk. S/S 
Compudisk D/S 

Maxise<:tor S/S 
Maxise<:tor D/S 

1-4 

14.00 
24.00 
35.00 

16.75 
24.75 

14.50 
19.50 

17.50 
26.00 

PRICE PER BOX 

5-9 

13.75 
23.50 
33.50 

16.00 
24.00 

14.00 
18.50 

16.75 
25.00 

Figure 2.8: Brooks' Price List 

10+ 

13.25 
23.00 
30.00 

15.25 
23.25 

13.50 
17.50 

16.00 
23.00 

With the normal tab setting, the text in the column is left-aligned with the tab point. In 
the instance of the decimal tab the information is aligned around the decimal point so 
that a column of figures will be properly lined up. To put in a decimal tab you need to 
place the arrow over the second icon on the ruler (the triangle with the dot in the 
middle) and drag it to the point on the ruler where you want it. To create the price list, I 
put one at the 4.5" mark and one at the 5. 75" mark. I also had to in normal tabs marks 
for the headings otherwise the text will be left-aligned at the position of the decimal 
tabs and look uneven. 

Line spacing 

In the middle of the ruler are three icons which represent different line spacing- single 
spaced, 1.5 and double spacing. To opt for a different spacing you just click on the 
appropriate icon and the current text is automatically changed. I normally stick to 
single spacing when I am typing in any document because to have wider spacing be­
tween the lines simply cuts down the amount of text you can have on the screen at any 
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one time. You can change the spacing when you print. For example, the new product 
letter above is quite short and may benefit from double spacing. 

Justifiction 

The four icons on the righthand side of the ruler represent four kinds of justification ­
left , centre, right and both sides . As with the other icons, you select the one you want 
by clicking on it with the mouse. Left or both sides justification is usually a ma tter of 
personal taste- whether you prefer a straight right edge or a ragged one. Right justifi­
cation is not frequently used. Centre justifying, however, can be very useful especially 
for setting up headings for documents. To show how centring can be used I have taken 
the example of the invitation to visit Brooks' stand at the computer show which you 
can see in Figure 2.9. 

Brooks Disks 

are going to be on 

STAND 90 1 at 

The South Midlands Computer Show 

on 

23rd August at 

Regional Exhibition Centre, Langton Green 

Come and see Brooks' revolutionary new disks! 

Figure 2.9: Exhibition Invitation 

When you have chosen a particula r type of justi fication it will also apply to tab settings 
as well so that the contents of columns wi ll also have the selected justification. This can 
be use ful if you want to centre your column headings or to align numbers at the 
righthand edge of the column. 

Conclusion 

This chapter has been primarily concerned with look ing at the standard word process­
ing features which Mac Write has. Some o f the features a re similar to those you would 
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find on a typewriter - for example, tab and margin settings a nd line spacing are 
standard typewriter facilities - but many others demonstrate the advantage of using 
a computer for word processing. 

One of the most powerful features of using a package like Mac Write is that you are not 
typing onto paper but onto a screen. This means that nothing you do is committed to 
paper until you have decided that it is exactly as you want it. MacWritegives you many 
ways of making changes and correcting your mistakes. Selecting and overtyping will 
cope with small spelling errors. Cutting and pasting will completely transform what 
you have written by reordering lines, sentences or paragraphs. 

When your document is ready, you can then print it, but not before choosing how you 
want it to appear, what size paper you want to use, how many copies you want, what 
quali ty of printing you need. All you have to do is choose your option on the screen, 
and Mac Write will do the setting up for you. 

After you have finished editing and have printed out your document, the computer 
then takes on the role of a filing system for you. It lets you save a copy of what you have 
produced in a file and stores it away on a disk for you until you need it again. A 
cumbersome filing cabinet is reduced to a series of 3.75" square disks. 

Although these features are common to most word processors, MacWr.ite does have a 
distinct advantage in that it makes using them very simple. The choices are mostly 
visible on the screen as and when you need them. They are ei ther icons or straight­
forward comments and questions . All you have to do is make your choice by pointing 
with the mouse. 

So far I have concentrated on the facilities which will allow you to set up straight­
forward documents. You should by now be quite familiar with these and feel at home 
using the mouse and icons. I mentioned at the beginning of the chapter that Macwrite 
had a number of more sophisticated facilities and in chapter 3 r shall be exploring how 
these work and what they do. 
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CHAPTER3 

More on Mac Write 

This chapter is mainly about making changes to the standard style, format and con­
tents of Mac Write documents. You have a lready learned how to write a letter in Mac­
Write. Now you are going to see how to create more complex documents with more 
interesting designs, concentrating on the Search, Format, Font and Style menus. 

Although word processing often involves a lot of keyboarding, writing long reports or 
mundane letters, there is also scope for imagina tion and inventiveness in designing the 
layout and presentation of various types of documents. Mac Write caters for this by 
having a wide selection of font styles and sizes for you to choose from . I am going to 
spend some time in this chapter looking at these features and ways which you can use 
them. 

As well as using different types of lettering to make a document more interesting, 
changes of format are often needed to indicate different sections or points within a 
document, and generally to divide it up into more digestible chunks. Few things are 
more difficult to tackle than a long rambling reports, with long paragraphs and few 
headings. To overcome these problems, the text needs to be broken down. This may 
enta il changing indentation, margins and justification so that different parts of the 
document are easily distinguishable from one another. These commands all have to be 
added to the document. In the section on document format I shall be talking in detail 
about how to add new formatting commands and alter existing ones. 

In the last chapter, I talked about how to make changes to the contents of a document 
by cutting and pasting or by overtyping. MacWrite offers an alternative method of 
making changes to a document - by means of the Search menu . This menu enables 
you to go right through a long report or whatever and pick out all the instances of a 
word or phrase. It is for those times when you discover that Mr Lee's name is actually 
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spelt 'Leigh' and that his name occurs at least twenty times in your report. I am going 
to take the Search menu as my starting point for this chapter and spend some time 
talking about how to use it to make alterations to the text. 

Finding and changing text- the Search menu 

The Hadley Engineering plant is looking for a warehouse manager and the current 
manager has written an advertisement to appear in the local newspaper. Figure 3.1 is 
what he produced. When he showed the advert to the fi rm's personnel director, it was 
pointed out to him tha t what he had produced was breaking the Sex Discrimination 
Act and he must change all references to 'he' and ' him' to 'he/ she' and 'him/ her'. 

Hadley Engineering are looking for a warehouse manager. The applicant 
must be aged between 25 and 35. He must have at least and HNC in 
engineering and two years· experience. He will be required to handle all 
aspeds of the running of the warehouse and will have 20 people working 
under him. The job offers tremendous prospects for career development 
for the right man. 

Please write with cv to - Mr McAuley, Hadley Engineering, Swindon Road, 
Cranley or for further information ring Cranley 23560. 

Figure 3.1: Job Advertisement 

To do this on the Macintosh you need to use the Search Menu. It gives you two options 
-Find .. . and Change .... Let's look at them in turn. 

Find .. . 

Find gives you the choice of finding a group of letters either as part of any word 
(Partial word) or as a complete word (Whole word). Let's take the example of the 
advertisement. One of the words which must be changed is 'man' which should read 
'person'. Select Find from the Search menu, type in 'man' and choose Partial word. 
Mac Write now looks for the first occurrence of the three letters 'man' regardless of 
where they are positioned. In the case o f the advert, the search will stop at the word 
'Manager' on the first line. To find the word 'man' on its own by this method, you then 
have to continue to search through the rest of the document and every other word 
which may contain the 'man' letter combination. 

It is particula rly important to remember how Partial Word works, especially if you are 
doing a global replacement. If you had done that with the letter combination 'man', 
replacing it with ' person', you would have ended up with 'personager' in place of 
'manager' on the first line. 
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Change ... 

In the advertisement, all references to 'he' must be changed to 'he/ she' and 'him' to 
' him/ her' . Change will allow you to make these alterations. T ake a look at Figure 3.2 
a nd you wi ll see that the Change option offers you the following five options 

r 
II Fi le Edit s(~ilnh rnrnmt rnnt '>t tjh' 

., 

~0 Chonge 
Had! 

1 ::,,.~ I 
mus ~ind what 

engi1 Chonge to 
aspe 

(Find NeHt) ( UuHHJI'. tlwn lind ) (!.!HHHJl' ) ( Change Rll) unde 
for t @ Whole Word 0 Portio! Word 

I 

Please write with cv to - Mr McAuley, Hadley Engineering, Swindon Road, I 
Cranley or for further information ring Cranley 2 3560 I 

I 

I 

l 
I 

Figure 3.2: Change/ Find Options 

I) Fi nd the next occurrence of the text. (Find Next) 
2) Change the first one found , then go on to the next. (Change, then Find) 
3) Change the currently selected incidence of a word. (Change) 
4) Change all occurrences of the selected text. (Change All) 
5) Use any of the four options a bove to find and change a whole or partial word. 

In the case o f the advert, I shall use option 4 to change all references to the whole words 
' he' and 'him' to read 'he/she' and ' him / her' instead. 

If you want to see how this works o n the example I have given, I would advise you to 
move the Change window to the bottom of the screen, since I found that when it was at 
the top, it covered most of the text so I couldn't see what was going on. 

Having chosen the option Cha nge All, Macintosh will warn you that this is an irrever­
sible change and lets you cancel your choice if you want to. If you are making changes 
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in a long document it is often worth going through changing each instance one by one. 
This is a bit more time-consuming in the first place than making a global change, but if 
you are not certain if you want to alter every single one of the words, then it wi ll save 
time later on trying to find the occurrences which were altered by mistake. 

As you become familiar with using Mac Write, you will discover that Find and Change 
are very useful commands and provide a quick way of altering words or phrases in your 
document. To take writing this book as an example, I found that I had been typing 
'Macwrite' rather than 'Mac Write' so I specified that I wanted to make that a global 
change. Change can also be used as a way o f making shortcuts in typing. To take 
another example, if you were writing about a subject with a particularly long name, 
you could put initials in the text and the full name could be inserted when the document 
was finished. 

Another use for the Search options is if you want to reuse a document written for one 
particular subject or person which is equall y applicable to another. One example 
which springs to my mind is that of Estate Agents' house descriptions where one 
week's ' Delightful Victorian cottage in the heart of rural Kent' becomes next week's 
'Delightful Victorian cottage in the heart of rural Surrey' -all that changes is the 
photograph a nd , of course, the price. 

Altering the document format 

People ringing up to enquire about the job advert isement placed by Mr McAuley will 
be sent a copy of the job description part of which is set out in Figure 3.3. 

When you are typing a long document which may run to several pages , you will often 
find that you will want to alter the format o f the page. This could be to make the 
margins narrower to separate a particular point from the rest of the text, for example. 
You may want to make the page shorter, so that a heading is not separated from the 
body of the next to which it applies. As the document gets longer you will want to put in 
page numbers and maybe a page heading. MacWrite has the facilities to make these 
changes a nd to introduce additional features into documents. They are stored in the 
Format menu under the options Insert Rulers , Hide/Show Rulers, Show Header, 
Show Footer, Set Page#, Insert Page Break and T itle Page. I am going to spend this 
section discussing how to put these features into a MacWrite document using the 
example of the job description which I mentioned above. 

In the example o f the job description, you will see in Figure 3.3 that the formal of the 
text changes several times throughout the page. At the top, the heading is centred and 
then the paragraph directly beneath is typed right across the page. The numbered 
points are indented slightly and most of them contain a subsection within narrower 
margins. Each of these different formats requi res changes to be made to the ruler. 
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Hadley Engineering Company 

Warehouse Manager 
Job Description 

September 7, 1984 

This document constitutes the duties, obligations and responsibilities of 
the person employed by Hadley Engineering in the capacity of Warehouse 
Manager. 

1. The Warehouse manager is responsible for the day-to-day running of 
the spare parts warehouse at the Barton Grange factory . This includes: 

Maintaining tight control of the stock levels of the 
warehouse. Reordering parts as and when 
necessary. 

Ensuring the prompt despatch of parts to any 
factory which requires them. 

Disposing of outdated stock in the most appropriate 
way. 

2) The warehouse manager must be responsible for all staff working in 
the warehouse. This includes: 

Recruitment and training of personnel. 

Settling any disputes which occur between people 
working in the warehouse. 

Keeping a check on absenteeism and sick leave. 

Dismissal of staff after written warnings. 

Paying weekly and monthly wages. 

3) It is the duty of the Warehouse manager to ensure the servicing, repair 
of all vehicles used by the warehouse. He/she is also responsible for 

the hiring or purchasing of new vehicles and the disposal of old ones. 

4) The upkeep and security of the warehouse buildings and fittings are 
also the manager's responsiblity. He/she must have regular 
maintenance checks made on the following: 
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Hadley Enginooring Company 

The roof and exterior walls of the warehouse. 
The internal and external doors and the security 
locks. 
The washrooms and staff changing rooms. 
The state of repair of the warehouse shelf network. 
The floor of the building. 
All fire fighting equipment and alarms. 
All light and heating fixtures. 

September 7, 1984 

The manager should be familiar with the relevant sections of the 
Health and Safety Act and should enforce those regulations at all 
times. Failure to do so could result in disciplinary action against the 
manager. 

Figure 3.3: Job Description 

Insert Ruler 

In order to make changes a t varying points in the text, it is necessary to add more rulers 
to the document. If you were to make the changes to the ruler which appear at the top 
of the document, each time you altered the settings, the entire document would 
change. It does not offer you the chance to make selective alterations at different 
points in your document. This is remedied by the Insert Ruler command, which allows 
you to put new rulers at any point in your document. 

To add a new ruler, you put the cursor at the point where you want to alter your format 
and then select Insert Ruler from the Format menu. The new ruler is simply a copy of 
the ruler which appears at the top of the page or the last one you inserted. If you have 
made any changes to the standard set-up on it, these will appear on the new ruler and so 
you will have to alter them. 

Here are the changes that I made to the job description format by inserting rulers at 
various points in the text. 

I) At the very beginning of the document l selected the centre justified icon, 
because I wanted to have the headings appear in the middle of the top two lines. 

2) However, I did not want the text itself to be centred, so I added a new ruler just 
below the heading. Issuing the Insert Ruler command brought me up a copy of 
the original ruler. The ruler still d isplayed centre justification and so I had to 
change this to left justification. I then typed in the first paragraph. 

3) I then decided that I would like the numbered points to be indented a little way. 
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This meant inserting anot~.er ruler and moving the lefthand margin in to position 
1.5 on the ruler. 

4) When it came to listing the specific duties of the manager under this point 1 
thought they might look better if the margins were narrower. I inserted yet 
another ruler which set the lefthand margin at the 2" mark and the righthand 
margin at the 6" mark. 

If you are following what I did on your own Macintosh you will see that by now the 
screen has more rulers on it than text. Let' s remedy that situation . 

Hide/Show rulers 

Unless I actually want to cha nge any of the rulers, there is no point in having them 
displayed all the time - they just take up space unnecessarily. The Format menu 
contains the option Hide/ Show Rulers. If the ru lers are displayed, selecting the 
option will hide them and vice versa. At this point, you wi ll probably want to tidy up 
your screen a bit and so hide the rulers. 

Even though you have hidden the rulers, you will fi nd that when you go to insert a new 
one, they will a ll reappear. 

More about rulers 

T he job description example has quite a number of changes of format in it which need 
rulers inserted. However , many of the changes are really just swapping backwards and 
forwards between the same formats. Since each time you insert a ruler it has the same 
set-up as the previous one, to use the usual method would mean having to keep making 
the same changes. An alternative method and the one which I used, is to make a copy 
o f the particular ruler you want to insert and instead of using the Format menu, using 
the Paste comma nd o f the Edit menu. 

As far as MacWrite is concerned, the rulers can be treated in the same way as any 
ordinary text. That is to say, they can be selected (by clicking above the actual ruler 
markings), cut, copied a nd pasted . Just as wi th normal text, any edit command carried 
ou t on a ruler can be undone. Similarly inserting and changing a ruler can also be 
reversed by the same Undo/Redo option of the Edit menu . 

Adding a header - Show/ Hide header 

The top lines of Figure 3.3 were not set up as an ordinary line o f text but were created as 
a Header . I d id this to ensure that the same line appears at the top of each page, but you 
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don ' t have to type it in each time. You will also see that there is a date displayed as well. 
This has been drawn from the system clock as you will see further on. 

Header 

-~-l ... . ... L .... l ... . .. l.? .... L. . .. l .... l_._.J.~ . .. l .. ~ .. J..., ... L. . .. l.1 .. l ...... J..., ... l. .. . .. J.5 ... .l .. ,•.i:•--1 ... • .. .J .~ •... l... . ... l... . .. l ... • .. l 

lll91B ~[§IE] ~~~~~ 

I 
Figure 3.4: Show Header 

If you select the option Show Header, you will be presented with a blank window 
divided into three (see Figure 3.4). The top part contains icons for the page number, 
the date and the time. You can incorporate any of these into your heading by dragging 
them onto main part of the window and positioning them on the top line of the main 
heading box. Beneath this first box wi ll be a ruler (provided the Show Rulers option is 
in force) and you can format your header. In the main part of the window is the 
blinking cursor line which will allow you to type in text. 

For my example, I chose the centre justification and typed in the words 'Hadley Engi­
neering Company'. By setting this up as a header, I can ensure that it will appear at the 
top of every page. It is a lso a good idea to put one or two carriage returns after your 
header otherwise it will appear on the line immediately above the main body of text 
which looks too compressed. 

I also added the date to my header. As I said above, the date is drawn from Macin­
tosh's battery-operated clock. This is an ideal way of adding the date, since it will 
change automatically if you produce later versions of the same document. 

If you don't wanl to have the Header displayed all the time you can use the Hide 
Header option to get rid of it . However, it must be displayed when you want to print 
otherwise it will not be included in the printing. 

Adding a page number - Show Footer 

Under the Show Header option I could have positioned the page number at the top of 
the page. I chose instead to put it at the bottom of the page. I did this by using the Show 
Footer option. 
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Show Footer gives you the same opiions as Show Header but will put its contents at the 
bottom of the page as opposed to the top . To put the page number in the footer, I used 
the mouse to drag the Page number icon into position in the centre of the page. When 
yo u drag the icon, Mac Write will only allow to put it on the top line of the footer. The 
same applies to the date and the time icons. 

Set Page# 

If you are typing a particu larly long document, it is often more convenient to divide it 
up into a series of smaller documents. This makes it quicker to move through a docu­
ment or search for something. However, when it comes to printing the document you 
may want it to look like one continuous piece of work. At the beginning of each 
document the page number is a utomatically set to I . To a lter this , you can use the Set 
Page# option which will simply a llow you to put in a new number for consecutive 
documents. 

Insert page break 

I found when I was typing in the job description that the end oft he first page came right 
in the middle of a list. As this looked rather messy, I put in a page break at the beginn­
ing o f the list so that it a ll appeared on the next page. 

Title Page 

If you do not want the header and footer to appear on the first page you can simply 
select the Title Page option. When you do this, a tick appears beside the option to tell 
you it is in force. Selecting the option again will turn it off. 

All the Format options give you a great deal of control over how your documents will 
look. You can change the margins, tabs, and justification as o ften as you like, and then 
change you r changes if you want to . Once again, you are not committing yourself to 
paper and so you can make as many alterations as you like. 

Cha nging the page format is the most significant option on the Format menu , but it 
also gives you the chance to make some useful minor additions and changes to your 
documents. Adding Headers and Footers to the pages of a document is a way of 
supplying extra informat ion for whoever has to read it. Being able to insert page 
breaks and change the page numbers are also useful features, which can improve the 
presentation o f documents. I am going in the next section to talk about other means of 
changing the appearance of a document, through using the Font and Style menus. 

45 



MASTER YOUR MACINTOSH SOFTWARE 

46 

Different Fonts and Styles 

Joanna Davies has seen Hadley's advert and has decided to apply. She has written a 
short curriculum vitae to send. I am going to use it as an illustration of different fonts 
and styles in MacWrite. The curriculum vitae appears in F igure 3.6. However let's 
begin by looking at the fonts and styles themselves. 

New York. liPY YoTII: 

Genevo Genevl:l 

Toronto Tor onto 

Monaco Monaco 
Chicago Cllic•t• 

Venice Venice 

lott~on ~ 

Athens 1[1~ 

Figure3.5: Fonts, Styles and Sizes 

Selecting the Font menu will present you with a list of names of cities- New York, 
Geneva, Toronto, Monaco, Chicago, Venice, London, At hens a nd San Francisco. 
Each one uses a d ifferent font. Take a look at F igure 3.5 to see what each one looks 
like. As you can see they vary from the very plain to the extremely ornate. 

In the same figure you will see that, as well as illustrating the fonts, I have also given 
examples of the Style features which are avai lable. These include Plain Text, Bold, 
Italic, Underline, Outline and Shadow. You can combine any number of these inclu­
ding all five of them. Selecting Plain text wi ll always switch off any of the other 
options. 

The Style menu also gives you the option of cha nging the size of the lettering. It gives a 
range from 9 point up to 24 point. The standard size is 12 point but you can change it at 
any time and certain of the fonts and styles look better in the larger sizes. 

T he example I have used is that of a c. v. where I have combined different sizes of 
characters. I changed the size by selecting a different point option from the Style 
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menu. You can alter any of the features at any point in the document and there is no 
lim it to the number o f combinations you can have. Depending on the combination of 
style and font you choose, MacWrite will suggest the best point size for that combin­
ation . Its suggestion will be the point sizes which are outlined on the Style menu rather 
than in black type . 

Curriculum Vitae 

Personal Details 
N6me: Joonn11 Dovies Age: 31 Pllte of /lirth: 22.3.53 

Address: 52, Manor Road, Cranley, CR3 7AT. 

Phone No. Cranley 9271 . 

Education 
1964-7 1 Cranley School for Girls 

1971-75 Cranley Institute of 
Technology 

Employment 
1975-83 Bridgley Road H11u1oge 

1983-84 Grant's Furniture Co. 

·o· levels in French, Music, Meths, 
Physics, Biology, History, English. 
"A" levels in Meths, Physics end 
English. 
3SC Engineering. 

Warehouse supervisor - This job 
entoi led being in charge of oil aspects 
of the stock control of the worehouse. 
I wos mode redundont when the 
company went bonkrupt. 
Stores supervisor - I hove been 
wori< ing on o temporory basis whi 1st 
looking foro permanent job. I hove to 
give one month"s notice. 

Figure 3.6: cv for Warehouse Manager Job 

For setting up the c. v. I used the following features 

(i) The heading was done in Geneva font, 14 point, emboldened and underlined. 
(ii) The sub-headings were Geneva font, 14 point, emboldened. 
(iii) I italicised the prompts in the persona l details section and used 12 point. I used 

ordinary style, Geneva font , 14 point for the details themselves. 
(iv) For the majority of the o ther details I used the standard point size 12 and normal 
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style text, emboldening only the exam and job titles. 

Once you have selected your styles, you are not perma nently committed to them. lt is 
possible to change them later on. You can do this by selecting the piece of text whose 
style you want to change and , while it is highlighted , making different selections from 
both the Fom and Style menus. You can experiment with tt"!e different fonts and styles 
until you have found one which sui ts the purpose best. Here are two examples of 
documents l talked about previously and which have had changes made to them subse­
quently. 

(i) Earlier I talked a bout the Warehouse Manager's advertisement. The current 
manager decided to put the advertisement on the staff notice board in case 
anyone wanted to apply imernally. So that it would sta nd out a bit more he 
changed the font sizes and did some alteration to the text. The result is in Figure 
3.7. 

Hadley Engineering 

are looking tor a 

Warehouse Manager. 

The applicant must be aged between 25 and 35. He/she must have at least 
and HNC in engineering and two years· experience. He/she will be required 
to handle au aspects of the running of the warehouse and wiU have 20 
people working under him/her. The job offers tremendous prospects for 
career development for the right person. 

Please write with cv to - Mr McAuley, Hadley Engineering, Swindon Road, 
Cranley or for further Information ring Cranley 23560. 

Figure 3. 7: Job Advertisement 

(ii) As well as being very useful, the ability to change character styling and sizes can 
be good fun . It' s also a great way to save mo ney on all kinds of fancy printed 
cards - you can create your own. If you remember, in Chapter 2, Brooks' was 
sending out invitations to their exhibition stand. To show how you could use 
style changes to good effect, I have taken the original invitation changed the font 
to San Francisco and increased the size of the lettering to I 8 point. It is illustrated 
in F igure 3.8. 
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BrookS UiSk S 

are going to be on 

SIANU gO I at 

The sooth MidlandS Computer Show 

On 

Regional Exhillition [entre, Langton Green 

[orne and 5ee BrookS' revolntionar1J new diSkS! 

Figure 3.8: Exhibition Invitation 

Conclusion 

I have covered virtua lly all the facilities avai lable in Mac Write now. I was concerned in 
this chapter with showing you how MacWrite supplements basic word processing 
features with a large range of additional features which make it a unique package . 

1 talked first of all about making m:nor changes to words or phrases in the text by using 
the Search menu- this wi ll help you to correct your more consis tent mistakes - one 
of mine is a chronic inability to type the word 'which' correctly. I usually end up with 
'whcih'. As I can more or less be sure of missing some instances of this on the way, it is 
really helpful just to be able to make a global change. 

Being able to alter the page format is another very important feature and one which is 
certainly not unique to Mac Write. What is different about Mac Write in this respect is 
that it makes making changes very simple. So often altering tabs and margins is a 
complicated business in word processing packages. Going back to alter them can take 
a considerable time as you search for hidden control characters in the text which then 
have to be painstakingly moved or removed. 
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so 

I have found tha t MacWri te's greatest potential lies in the a bility it has to change fo nts 
and letter sizes. The constraint in many packages lies in the fact that the variety o f text 
available is so limited. Bold and underline are o ften as far as they stretch a nd char­
acters per inch is their only way o f altering the size o f the lettering. Different fonts are 
often only available with much alteration of printer switches, sending of Escape codes 
and even purchasing special cartridges. MacWrite gives you a whole range of fonts and 
sizes with one or two clicks on the mouse . 

ln this chapter I have shown only the basics of how these faci lities work , with some 
small examples of how you can introduce them into simple documents such as an 
invitation or an advertisement. They can however, be very powerful and you can enjoy 
experimenting as much as you like. I a m going o n in C hapter 4 to look at applicatio ns 
where you can ma ke full use of them for a range of business purposes. 



CHAPTER4 

Applications using Mac Write 

As well as giving you a chance to practise using the features described in chapters 2 and 
3, I shall a lso be introducing some of the ways in which you can use Finder featu res in 
MacWrite. The main theme of this cha pter, however, is how to use Mac Write to set up 
a series of what I call standard documents. I have used the next section to describe what 
I mean by this and to illustra te with several examples of the types of documents you can 
produce . 

Standard documents 

In business, a large proportion of correspondence seems to revolve a round sending out 
letters whose theme runs thus: 

Dear Sirs, 

We tha nk you for your enquiry but we regret we a re unable to help ... 

Yours faith full y ... 

No one needs advice on how to wri te such letters, but they do constitute a particular 
kind of document for which Mac Write can be extremely usefu l - the sta ndard letter. 
A company may have many enquiries which it is not able to answer positively. A few 
lines sto res in a fil e on a disk can have a name a nd address added to them to make a 
perfectly adequa te, if negative, reply to a n enquiry. 

Standard letters a nd other documents need not be restricted to short letters as 
illustrated above but can be detailed and fulfill a wide variety of different purposes. In 
essence, what standard documents do is help you to save time in typing while retaining 
the illusion of individually produced, personalised pieces of work. 
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In this chapter, I shall be exploring a number of the possibi li ties which setting up 
standard documents can provide for business purposes. As well as looking at writing 
letters, I shall also be taking some examples of setting up standard skeletons and 
forms. 

One of the most useful facilities of Finder in setting up standard documents is the 
Scrapbook. So, before I start giving examples of ways to create the documents, I am 
going to make a slight detour to talk about the Scrapbook, what it does and how it 
works. 

Scrapbook 

Whenever you want to cut or copy anything in MacWrite, the text is stored in the 
Clipboard. The contents of the Clipboard will always be overwritten by the next piece 
of text you cut or copy. Scrapbook is similar to Clipboard in that you can store infor­
mation to it, but it has the advantage that what you store is kept permanently. It can 
keep information from both MacWrite and MacPaint and , as you will see later, this 
informtion can be transferred from one to the other. 

Each item is kept individually. You can browse through the contents of the Scrapbook 
by using the scroll bar at the bottom of the window. Any text which you store in the 
Scrapbook will not have any style or font changes displayed. Don't worry about this, 
they will be restored once the item is pasted back into a MacWrite or MacPaint 
document. 

Since Scrapbook stores the information permanently, this means that you can keep 
pieces of text which you can use again and again in different documents. This can be 
very useful in building up what appear to be personalised letters from a series of stand­
ard pieces of text. In the next section I shall be showing you how this can be done to 
good effect. 

Standard paragraphs 

G&G Investments is a sm all company which invests people's money for them in a 
variety o f Bonds, Units, Shares etc. To keep in personal contact with investors, they 
like to tell them how their investments are doing each month. They have about ten 
different funds in which they invest , so each month they write a short paragraph about 
each. Not every customer inves ts in exactly the same funds, so G&G keeps the para­
graphs as separate items and then brings the relevant ones into each letter. 

Look at the letter in Figure 4.1. It has been constructed from several o f these standard 
paragraphs. Mrs Murray invests in three funds- Far Eastern Oil Bonds, Eurogold 
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Units and Korean Precious Metals and so those are the only paragraphs which will be 
included in her letter. 

Monthly Report 

Dear Mrs Murray, 

I am writing to give you a report on the progress on your investments with 
our company. 

Far Eastern Oil Bonds have had a very good month with substantial gains 
on the Hong Kong Stock Exchange despite strong pressures from other 
companies. We feel that this upward trend is likely to continue for the next 
few months. 

Trading in Eurogold Units has ~ quite slow for the past few months 
but with the rise in interest rates they will certainly rise sharply in the 
coming weeks and you will begin to see marked improvements in their 
returns. 

Korean Precious Metals are continuing their steady rise and have been 
providing most satisfying results for their investors. We look forward to a 
continuation of this boom. 

Please find enclosed a copy of our Investors News bulletin Which will keep 
you up to date with new developments and investment possibilities. 

Yours sincerely, 

G&G Investments Ltd. 

Figure 4.J: Standard Letter to Investors 

To construct these paragraphs on the Macintosh, each one can be typed on the Mac­
Write screen and then cut and pasted into the Scrapbook . When you do this, 
Scrapbook is treated exactly like a file and the text is transferred to and from it via the 
Clipboard using the Edit options. 

When you want to set up a letter with the standard paragraphs you should copy them 
from the Scrapbook , then close it a nd paste them into the document you are currently 
working on. Since the letters are really just for the sake of good customer relations and 
the information they contain is not particularly vi tal, there would be no need to save 
the individual letters. After you had printed one letter, you could use the same file to 
recreate the next just by substituting the new customer name and the required par­
agraphs. 
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Standard clauses 

Just as G&G were able to take advantage of the Scrapbook facility for their standard 
paragraphs, so the same facility can also be of great use for preparing contracts. 
Although a contract may have some points which are unique to it, other standard 
clauses are usually added. Such clauses will cover things like indemnity or bankruptcy 
-instances where the procedures would generally be the same. 

3. Indemnity 

Each party shall indemnify and lc.eep indemnified the other 
against injury (including death) to any persons or loss of or 
damage to any property which may arise out of the acts, default 
or negligence of any such party's employees or agents in 
performance of such party's obligations under this agreement 
and against all claims, demands, proceedings, damages, costs, 
charges and expenses whatsoever· in respect thereof or in 
relation thereto, provided that AMV shall not be liable for nor 
be required to indemnify you against any compnsation or 
damages with respect to loss of profits or consequential loss 
howsoever cau!>OO or arising. 

4. Termination 

Without prejudice to any other rights AMV may have in the 
event of either party becoming ban.lc.rupt or making an 
arrangement with its creditors or going into liquidation, or upon 
any breach of you by your obligations which is incapable of 
remedy or if capable of remedy is not rectified within 14 days 
of being brought to your attention by AMV your licence shall 
tllereupon terminate. 

F igure 4.2: Standard Contract Clauses. 

In Figure 4.2 I have shown examples of two such standard clauses. Although I have 
actually numbered the clauses and they refer to a specific person (AMY), both the 
numbers and the name can easily be changed (a straightforward global change will 
replace all instances of the original name in one go) so that the same clauses can be 
incorporated into any document. 

Although I would normally rely on lawyers to draw up original documents for me, I 
have also found that I have taken what was prepared by them and adapted it for other 
pu rposes using the parts I needed and cutting out the ones I didn't. Having the Macin­
tosh makes this very easy as I can keep various useful clauses to add to other docu­
ments I have devised myself. 



APPLICATIONS USING MACWRITE 

Standard forms 

Designing forms in MacW rite can be a big advantage in two ways. Firstly, it means 
tha t, unlike preprinted forms, you are not in danger of accidentally running out of 
them through forgetting to order more. Secondly, with the form actually stored on the 
computer you can type the details straight into it, you don't have to worry about 
get ting the page positioning right. If you make any mistakes they can be altered on the 
screen before the document is printed and you won' t have ruined a printed form and 
the four carbon copies that usua lly come with it. 

I have used MacWrite to set up the skeleton for an invoice, with the correctly posi­
tioned tabs and headings a nd then I used a couple o f the Finder facilities to help with 
adding the details . Figure 4.3 shows the skeleton invoice. 

Item 

Invoice No. 

Description Price 

Subtotal 

VAT 

Total 

Figure 4.3: Skeleton Invoice 

Qty Total 

The basis o f setting up the invoice skeleton was to insert several Rulers to centre the line 
which reads ' Invoice No.' and to insert the tabs for the columns where the invoice 
detai ls wi ll be entered. I ma rked the rightha nd colu mn with a decimal tab so that all the 
figures would be aligned correctly. 

fused Finder's Alarm Clock facility to put the date at the top of the page. As with most 
o f Finder's faci lit ies, it is possible to copy a nd paste information from the Alarm clock 
into a MacWrite document. 

Another feature of Finder which can be useful for setting up a n invoice is the calcula­
to r. Thanks once again to the fact that you can copy and paste from it, I was able to use 
it to do the calculations required - I multiplied the price by the quantity to get the total 
which I then copied to the Total column a nd the Subtotal space. With the result of the 
multiplication still stored in the Calculator I calculated the VAT by multiplying it by 
. 15 (unfortunately, the Calculator has not got a percentage function). Once I had 
inserted this figure in the invoice, l added the original tmal to it and the invoice details 
were complete. 
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I could probably have done the calculations on my ordinary pocket calculator just as 
quickly, but the advantage of having the built-in facility on the Macintosh is, from my 
point of view, that it reduces the possibility of errors creeping in through figures being 
wrongly copied from the calculator to the machine. The less room for error the better 
as far as I'm concerned and if this cuts down on invoices being queried and payments 
delayed then it can be quite an advantage. Figure 4.4 shows the finished invoice. 

Marchant Co. Ltd., 
Green Lanes 
Cranley. 

Item Description 

Bifurcat.e<i Rivets 

Invoice No. 2750 

Price Qty 

.50 500 

Subtotal 

VAT 

Total 

Payment terms: 28 days. 

Figure 4.4: Invoice 

30/07/ 1984 

Total 

250.00 

250.00 

37.50 

287.50 

Of course, you a re not restricted to using this type of set-up just fo r invoices. Purchase 
Orders, quotations, credit notes and so on all need calculations in them and once you 
have set up the basic format for one, it is not very difficult to make the minor alter­
ations necessary to transform a n invoice into a purchase order. 

Using the Special character set 

Choose the Apple menu and select the Key Caps option. Now press the Option key on 
the actual keyboard. You will see that the character set on the Key Caps keyboard 
changes to reveal a different set of characters . The characters are a mixture of Greek 
letters, mathematical and other symbols and accents used in foreign languages - for 
example a cedilla on the c, a grave accent, umlaut and circumflex. These are not the 
kind of symbols that you would use everyday but they can come in handy if you have to 
write letters to foreign companies. 

In Figure 4.5 there is an example of a letter written in French which illustrates the use of 
some of the special characters. 
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Paris, le 4 aotit. 

Messieurs, 

Nous vous remercions bien de votre lettre du 12 juillet. Nous avons bien 
considere votre proposition concernant I "Exposition International de 
Commerce. Cependant, nous avons decide que nous ne sommes pas un assez 
grand commer~ant d ·y mer iter notre assistance. 

Veuillez agreez, Messieurs, !"expression de nos sentiments les plus 
distinguees. 

Paul Mercier et Fnkes, Paris. 

F igure 4.5: Letter in French 

T he characters used in the example are a n acute accent, a grave accent , a cedilla, and a 
circum nex. These cha racters are stored in a number of d ifferent places on the key­
board and you need the foll owing seq uences o f key presses to access each one : 

Grave accent: thi s is stored on the key directly a bove the righthand shift key. Press it 
a nd then press the letter over which you want it to appear. It will only 
appear in the correct position over a vowel and a fter you have pressed 
the letter, so don't worry if it doesn' t appear immediately. 

Acute accent: to get a n acute accent over a vowel, press the option key a nd the letter 
' e' at the same time . T hen press the ' e' key again to put a n accent over 
the e. 

Cedilla: the cedilla only appears on the letter 'c' so that the combined char­
acter will be typed when you press the option key in conj unction with 
the 'c' key. 

Circumflex: the circumnex is stored as Shift 6 a nd will appear over the next vowel 
key you press after the shi ft 6 combination . 

If there are a ny occasions where you want to use a character which is no t on marked the 
Macintosh keyboard, then using Key Caps will reveal to you whether o r no t that char­
acter is avai la ble. Not every font style will allow you to use all the special characters 
and if a cha rac ter is no t accessible it will be replaced by a bla nk squa re. 

Further ideas 

In thi s sectio n I am no t going to go into a ny de tail on how to set up the examples since I 
have covered all the featu res o f MacWrite. The examples are there to provide more 
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ideas of ways in which you can use MacWrite for all kinds of documents which you 
probably use everyday. 

ORO OKS DISKS lTD. 

ORDER FORM 

Compeny ... ...... .. .... . ....... . Phone No . . . ......... .. .. . 
Address . .. . .... . . . ... .. ....... . 

Item 1 . ......... . ...... . ............ . ... . .. Si ze . . .. . ..... . 
2... . .. ......... .. . . . . . . . . . . . . . . . . . . . . . .... .... . . 
3 . .. ..... . ..................... . ...... . . ....... . . 
4 . ..... . .... . ........................ . 

Delivery Dale: . .... .. • ......... 

Authorised signoture ..... . ................. . . . . . ... .. ...... . 

Position. . . . . . . . . . . . . . . . . . . . . . . . . Date . . .... . . ... . ... . . . . . 

Figure 4.6: Order form. 

Order Form 

Figure 4.6 illustrates how to set up a customer order form and it could be used as an 
addition to the price list. To add it to the bottom of the price list you would have to first 
of all put a copy of the order fo rm into the Clipboard (or the Scrap book if you wanted 
to use it again) and then open the price list file a nd paste it onto the bottom. 

Newsletter 

To produce the company newsletter shown in Figure 4.7 I made use of different font 
sizes to set up the headings. If you have a document which is broken down into various 
sections and subsections, it can be helpful to use different font sizes to indicate the 
levels o f each section - starting o ff with a large font for the major heading and 
decreasing the heading size with each level down. 
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OM Investments News Bulletin 

Apply now for Gold Shares 

The major news for investors this month is the British National Gold 
Corporation is offering its shares to the public for the first time. This news 
comes after weeks of speculation about the corporation's future after the 
government announced it would be sold off 'in the very near future'. 

The shares are to be sold at £ 1.50 each and BNCG should raise something 
like £75 million from the flotation. With the current situation on the gold 
market, we feel that an application for some of these shares could prove to 
be a good investment. 

Gilt Investments 

Although Gilts are not the most exciting of markets they do provide a safe 
haven from the more precarious equity market. They are also expected to 
provide useful profits over the next twelve months including a dividend on 
the funds. 

With tax changes affecting the short dated stocks, the better investment at 
the moment would appear to be the medium to long term stocks. 

If you are interested in either of the above tW'O areas, please let us know 
and we shall be happy to purchase units for you or send you details of 
investing through bonds. 

Figure 4. 7: Investors News Bulletin 

Memo 

Memos are easy to produce using Mac Write. In my example (Figure 4.8) , I have used 
the Show Header facility to set up an extra heading and to give the date. This means 
that on a memo which ran to more than one page, it would appear at the top o f each 
page. To illustrate the often hurried nature of the production of memos I have used the 
draft quality print option which produces a sma ller sized type and plain font. It also 
cuts out the process of saving a printed copy before printing and it prints much more 
quickly. 
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Priv~te ind Confid•ntlil - for iUthorised personnel only December 12, 1984 

Heme 

To : baud of directors. 

From : A.J. Burlington, Ch~irmin. 

rl! : pr-oposed t&l<eov•r bid by Bl&ndford Trust. 

Lut Frid.ay, rtceivtd notice 

Bl.andford Trust for the H.adley 

of in .attempted til<eovtr bid by the gi.ant 

Bnginuring Comp.any .and its subsidi•ril!5. 

At the prntnt moment I do not ful t h.at such i bid would bt in the bnt 

internts of tht compAny •nd I would Advise the baird strongly to re,ilct 

~ny ~dv~ncn mAde to them from Bl~ndford. 

In light of this off•r from Bl•ndford I wish to c~ll ~n extriordinAry baud 

muting for Fridiy 31st August it 2.00 p.m. when wt ca.n discuss this 

m~tter further. 

In the muntimt, would requtst that the bo~rd mtmbtrs not discuss this 

m.atter with ~nyone to .avoid ~ny adverse effect on our drudy delic~te 

position. 

A.J. Burlington. 

Figure 4.8: Confidental Memo. 

Conclusion 

As you will have seen by now , Mac Write has great versatility. In chapter 2 I started by 
talking about a short letter. As l went on to explore the different functions in Mac­
Write, so I introduced more complex types of document to illustrate them. Each ex­
ample was designed not only to show how to use a particular feature but also to give 
you ideas on ways in which you could apply Mac Write's facilities to your own needs. 
With that in mind, I looked not only at letters, but lists, invitations, adverts and other 
equally practical documents. 

In this final chapter on Mac Write on its own (I shall be looking at combining MacPaint 
and Mac Write in Chapter 8), I have concentra ted largely on the types of documents 
you can produce. I put the main emphasis G>n giving examples of what word processors 
are best at - producing standard documents. No matter what type of business you 
run, there is always a need for some kind of standard document- the stock reply to 
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failed job applicants, the personalised information sent to customers, skeleton forms 
for invoices and so forth. 

Some types of standard document can simply be printed out once and then photoco­
pied as often as needed. However, others remain more or less the same each time you 
use them but need minor adjustments- like changing names or dates or figures. In 
these cases you are not cutting out the need to do some editing, but you are making it 
quicker to produce the individualised documents because you already have the bulk of 
the document prepared. 

Another kind of document I looked at in this chapter was one which was made up of a 
selection of standard elements. Such a document or letter may be made up entirely of 
prewritten paragraphs, as with the example of the investors letter , or of some specially 
written parts combined with some standard elements, for example a legal document. 
Once agai n, the main aim is to cut down the amount of time you have to spend prepar­
ing documents. Of course, you still need time to collate a letter made up of prewritten 
standard paragraphs, but you don't need to type in all the details again and again. This 
not only reduces the time spent typing but also the scope for making errors. 

Some other features of MacWrite are perhaps not so immediately apparent as those 
which appear in the menus and on the Ruler. These are features that are kept on the 
Finder menu. You may have thought of them as being part of Finder but not necssarily 
being directly applicable to Mac Write. Scrapbook is probably the one feature which is 
most obviously useful. However, as I illustrated in this chapter, facilities such as 
Calculator, Alarm Clock and Key caps can be used to good effect in setting up docu­
ments like invoices and foreign letters. 

In these three chapters, I have really only begun to look at the ways in which you can 
use MacWrite. What you will have discovered is how simple it is to use and how 
versatile its facilities are. I hope also that I have provided you with some ideas of when 
and where you can use Mac Write and that you wi ll build on those ideas yourself and 
apply MacWrite's features to a ll the documents you want to produce. 
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Introduction to MacPaint 

MacPaint is an ingenious program which allows you to draw all manner of pictures, 
diagrams, shapes and designs. When I first used it, MacPaint reminded me rather of 
one of those drawing toys that are made for children, but to describe it as such is to 
underestimate its facilities. Certainly, it can be great fun to play with, but MacPaint 
also has a huge number of very practical uses as you will be finding out. In the next 
three chapters, I am going to be exploring not only how the individual features of 
MacPaint work, but how you can use them for a wide range of business purposes. I 
shall be showing you how to use it to draw flowcharts, company logos, and scale 
diagrams as well as giving you ideas on how to develop your own designs. 

This introductory chapter is going to concentrate on how MacPaint works and how to 
use some of its basic features. Although most of the features of MacPaint are fairly 
self-explanatory, learning how to use them effectively takes time. You need some 
practice to be able to manoeuvre the mouse with sufficient accuracy to achieve good 
results, so look on this chapter as being a practice session to get you familiar with the 
MacPaint facilities. 

The MacPaint screen 

When you enter MacPaint, the screen appears as in Figure 5.1. At the top is a list of the 
available menus - these should be familiar from using Mac Write with the exception 
of the Goodies menu. I shall be talking about what each contains as I go along. Down 
the side you will see the most important aspect of MacPaint- the tools, each of which 
allows you to draw some kind of line or shape. In the bottom lefthand corner is a 
selection of lines of different thicknesses- these are the different borders you can put 
around your shapes. Along the bottom of the screen is a who e series of patterns -
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Figure 5.1: MacPaint Screen 

they are used in conjunction with several of the main tools. Finally, the main area of 
the screen is the drawing window. 

The drawing window 

Although the MacPaint window looks quite similar to the other Macintosh windows it 
functions slightly differently. You will notice that the scroll bar and the box to enlarge 
the window are missing. Similarly if you try to move the window by dragging it, no­
thing will happen. The position and size of the window a re fixed . This is because of the 
constraints imposed by the tools,and other boxes, which surround it. They are perma­
nently displayed. Of course, this does not mean that the size of your drawing is limited 
to the current area displayed by the window. In fact, the window exposes just one part 
of a much larger page which is at your disposal for drawing. When you come to draw 
something a little further on you will see how to use the Hand tool to move the window 
to different areas ofthe page and also how to look at the whole page. 

The tools 

MacPaint gives you twenty tools to work with and they are mainly for drawing differ­
ent lines , shapes, text and shading. They also incude options to erase the screen, to 
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move the window to select individual items on the screen, and to make changes to 
them. I shall be describing each of these in some detail. For the moment, however, I 
just want to look at how to access each of the tools and how one is distinguished from 
another. 

When you first enter MacPaint, the Paintbrush tool is always highlighted. If you move 
the mouse arrow onto the main window, it changes to a small black dot. Just moving 
the mouse around the screen won't actually draw anything. Nothing will happen until 
you press on the mouse keypad. Once you start dragging the mouse, it will begin 
drawing shapes and lines following the directions in which you move the mouse. In the 
case of the Paintbrush, it will draw a thick black line on the screen . 

In order to change tools, you put the mouse arrow on the one you want to use and click. 
That tool will immediately be highlighted and the pointer used on the window will 
change. Try clicking on the pencil icon and then move on to the window. You will see 
that the pointer has now taken the form of a pencil. 

Borders 

MacPaint gives you a choice of five thicknesses of line that can be used for the borders 
o f shapes. If you select the top option of the five, the dotted line, any filled shape you 
draw will not have any border. 

Patterns 

There are 38 patterns to choose from in Mac Paint. They are displayed at the bottom of 
the screen , with the current pattern displayed in the larger box at the beginning of the 
row of patterns. When you start using MacPaint this pattern will be plain black, but it 
can be changed at any time simply by clicking on the appropriate pattern box. 
Whichever pattern you choose will be the one which fills shapes or colours any lines 
drawn with the Paintbrush. 

You can also edit the existing patterns to create your own, although for the most part, I 
have found that the range already available is quite extensive enough. 

The menus 

Six out of the seven menus will probably be familiar to you from Finder and Mac­
Write. They give most of the same options with certain additions. For example, Mac­
Paint has some la rger font sizes than Mac Write and the Edit menu has options which 
all ow you to turn your drawing sideways or upside down. The only menu unique to 
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MacPaint is the Goodies menu which gives you a range of options to Jet you edit 
patterns and drawings . 

The menus, tools , patterns a nd borders are the components which make up Mac Paint. 
You will find that from the basic components it is possible to create a huge number of 
different combinations. In some instances, different combinations of tools and pat­
terns in fact produce the same results and, as you become experienced in using Mac­
Paint, you will find yourself using some combinatio ns more than others. I do not 
intend to cover every one of them . My aim is more to show you how to use the main one 
and to give you ideas on what to use them for. From that point, you will be able to go 
on to develop your own ideas on using the other features. For the moment, however, 
let's go back to the basics and first, a little drawing practice. Get your pencil ready. 

MacPaint gives you several ways to draw lines- Pencil will draw thin, free-form lines, 
Paintbrush draws free-form lines of varying thicknesses, shapes and patterns accord­
ing to the brush sha pe and pattern you select. Lines will draw straight lines of any 
length. I a m going to look at how to use each of these in turn. 

Pencil 

When you are using Pencil, every minute movement, every slight wobble of the hand, 
is faith fu lly recorded on the screen . The very thin line shows up changes of direction, 
however small. Because it is so sensitive, it is a good way to get used to moving the 
mouse around accurately. 

First try writing your name on the screen. If it looks a nything like my first effort it wi ll 
probably look live a seven-year old's first attempt at joined-up writing. 

I f you did attempt some doodling on the screen you can quickly get rid of the evidence 
by using the E raser. T he Eraser will allow you to rub out sections of a drawing by using 
it rather like a blackboard rubber, or double-clicking on the Eraser icon which wi ll 
clear the whole window. 

For some real practice at drawing accurate lines. I chose the example of tracing a ma p 
o f Great Britain. As well as being a way of illustra ting the use of Pencil, it will show 
how to use certain other tools to build up a map. I am going to take a skeleton map and 
gradually build on it, so that, by the end of ~he chapter, it will be divided up into the 
different sales areas throughout the country and will show who manages each area in 
the Hadley Engineering Company sales department. I started to build the picture up by 
drawing the basic outline o f the map which is shown in Figure 5.2. 
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Figure 5.2: Map outline 

Solving problems 

It took me three or four attempts to get the map to resemble the shape of Great Britain. 
I found that I had several problems to overcome, and corrections to make to my 
picture. Since the ways of correcting pictures are applicable to all the methods of 
drawing, I am going to take a look at them now . 

The basic problem I had was getting the shape right - I had to keep making adjust­
ments to the lines. I have already mentioned Eraser as one method of correcting mis­
takes but, as you may have discovered, it rubs out a large area at a time and it is not 
always possible to erase as accurately as you might like. To get greater accuracy you 
need to enlarge the picture and see exactly what you are doing. 

Fat bits 

You may have seen this option on the Goodies menu. As a shortcut to using the menu, 
you can access FatBits by double-clicking on the Pencil icon (this is just one of a whole 
range of shortcuts illustrated in Table 5.1). FatBits can be very useful if you want to 
make minor changes to your map since it enlarges the area of the map you are working 
on, which then appears as a greatly enlarged series of dots. In the top left corner of the 
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window there is an inset square which shows a section of the map in its actual size so 
that you can get a clear idea o f how the changes you make will effect the picture (See 
Figure 5.3). 

untitled 

Joptionlf!:} ...Uitiple Copi~ 

Joptionl Patterned Lines & Borders 

IOptionl {I Scroll FetBits Double 
Cl ick 

Select Window 

Show Page 

Brush Shape 

FetBits 

Erase Window 

IL] {I Enter or leave FatBits 

I!:] I] Change Font Size 

IL)lShift I~ Change Font l~fl' Edit Pattern 

~00000000000~ 
DOOOCIJOo::JOOOOO 
CJOOOOOOo::JOOCCJ 
~OOOOOO[][][]c::J 
~ DO 

Table 5.1: Short Cuts 
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Figure 5.3: FatBits 
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When you have enlarged the picture you can add or delete dots until you are satisfied 
that the picture looks exactly as you want it to. You can then return to the normal-sized 
picture by double-clicking again on the Pencil icon . 

Undo 

Sometimes when I used the Eraser, I fo und that I had moved a bit too quickly and 
rubbed out more than I had intended to. This is easily done but it is also easily rectified. 
On the Edit menu, the first option is Undo. ll will change the picture back to how it 
looked before the last move you made with the mouse . You can flick back and forth 
with Undo, undoing and redoing your last action. However, it will only be effective on 
the very last thing you did. If you click the mouse again after you've erased something 
then trying to undo it will have no effect. 

Moving the window 

While I was drawing the map I was so intent upon getting the shape right that I didn't 
pay any attention to the size and I found myself at the top of the window while only 
having reached as far north as Carlisle. Rather than retrace the whole thing again, it is 
better to move the window. 

If you remember, I said earlier on that the window was in fact only part of a larger 
page. To move to a nother part of the page, you use the Hand tool which pushes or pulls 
the window in the direction you move the mouse. I wanted to get some more space 
above the current window position, so I used the Hand to pull the picture down. 

Of course, this meant that I couldn 't see the whole of the picture on the screen at one 
time. However,the Hand icon has another function which acts as a shortcut to a fea­
ture which appears on the Goodies menu as Show Page. Double-clicking on the Hand 
icon reveals a smaller picture of the whole page. The position of the window on the 
page is indicated by a rectangle. (See Figure 5.4). You can move the window position 
by putting the arrow inside the rectangle and dragging it. It is a lso possible to move the 
picture itself to a different place on the page. You do this by putting the arrow outside 
the window rectangle and dragging. 

Drawing the outlineofthe map was the most difficult thing to do. Once I had finished I 
found there were some parts that didn't look right. To change them, I used a combin­
ation ofFatBits to make the corrections and the Hand tools to move round the outline. 
You can use the Hand whilst you are using FatBits. All you need to do is press the 
Option key on the keyboard and the Ha nd will appear. You can then scroll the en­
larged drawing. FatBits is deactivated by double-clicking on the Pencil icon. 
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Figure 5.4: Show Page 

Once you have finished drawing the map, save it to disk so that you will have a copy if 
you should accidentally erase the picture while working on it. The Save option is kept 
on the File menu as with Finder and Mac Write and will give you the same procedure to 
follow. Having saved the file, you are ready to go on to the next section. 

Paintbrush 

Take a look at Figure 5.5. In it, you will see the original outline of the map surrounded 
by two bands of a dotted pattern. These are intended to indicate different sea levels 
around the coast. I added these bands using Paintbrush. As I mentioned earlier Paint­
brush will draw a line in the pattern, thickness and shape ofline you select. For the first 
line, I used the standard Paintbrush line and a widely spaced dot pattern. For the 
second, the same line but a denser dot pattern. 

The main problem I had when tracing the edge of the map with the Paintbrush was 
drawing over the pencil lines I had drawn previously. As I said before, Undo will repair 
damage done to a limited degree. There are occasions however when the only answer is 
to start again. Provided that you have saved a copy of the drawing to a file on disk, it is 
possible to use the command Revert to start again without harming the picture. Revert 
is, in fact , a method of reloading a file from disk . If you are using a separate disk for 
storing your files then you will find that Macintosh will eject the disk you a re currently 
using and ask you to insert your document disk so that it can access the saved file. 

Paintbrush offers and incredible range of brush shapes. They are illustrated in Figure 
5.6. Brush Shapes is an option on the Goodies menu, and it can also be accessed by 
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Figure 5.5: Map OtJtlined with Paintbrush 

double-clicking on the Paintbrush icon. The current choice of shape is marked by a 
square. Changing shape is a matter of clicking on the one you want to use. In addition 
any of the patterns can be combined with the brush shapes. The Goodies menu has 
another option, called Brush Mirrors, which will draw mirrored pictures using Paint­
brush so that you can create symmetrical patterns . 

• • / "' • • / " 
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Figure 5.6: Brush Shapes 
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In this section I have only shown one way of using the Paintbush, but as I introduce 
more ways of using MacPaint I shall be giving further examples of how to use the 
Paintbrush. 

Area Fill 

The Area Fill tool is represented on the MacPaint screen by an icon of a paint tin being 
tipped up. To illustrate how the Area Fill works, I have divided up the map of Great 
Britain into several parts representing the sales areas of the Hadley Engineering Com­
pany. H aving done that , I am going to fill each area with a different pattern. 

To do this, I first have to draw lines across the map to divide it into seven a reas. Then I 
select the Area Fill tool and a pattern . I move the mouse on to the area I want to fill and 
click. T hat area is immediately filled with the pattern I have chosen. I repeat th is action 
for each of the areas, changing the pattern each time. 

Problems 

One of the most likely problems you will encounter when you are filling in areas is that 
there will be very small gaps in the lines you have drawn and the colour will ' leak' 
through the gaps and cover a larger a rea than you had anticipated. It only takes a gap 
of one dot and the pattern will spill onto the whole screen. If you find this has hap­
pened, Undo the Area Fill at once, or if you have already clicked on the mouse since 
then, you will have to use Revert to reload the last version . You cannot refill an area 
with another colour because once a pattern is in place, MacPaint t reats every line and 
dot of the pattern as a limit on the area to be fi lled a nd will not paint over it. 

If you have managed to Undo the Area Fill, using FatBits and the hand tool to go along 
the outline of the drawing to see where the gaps have been left and then fill them in 
using the pencil. It is worth going right the way round the drawing using Fat Bits since 
tiny gaps are very hard to see on the ordinary size drawing and even more difficult to 
correct. 

Area Fill will only be effective on the part of the drawing which is visible in the 
window. The part which is hidden must be pulled into the window and the Area Fill 
tool used again to fill in the other parts. 

In F igure 5. 7 you can see the end result of my area fi lling exercise- Great Britain is 
divided into seven differently patterned areas. To finish off the map I am going to put a 
key to the different colours with the names of the sales managers responsible for each 
area. 
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Figure 5. 7: Map divided into Sales Areas 

Figure 5.8: Map with Key 
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Straight lines 

Figure 5.8 is a picture of the map with the key in place. I drew the key by using the 
straight line tool. When you use the straight line tool as long as you keep your finger on 
the mouse key pad, the line wi ll continue to be stretched and shortened as you move the 
mouse. This means that you can manoeuvre the line until you have it at the correct 
angle and length. ~nly when you release the mouse pad can you draw another line, or 
continue the same one in a different direction. 

There is an additional feature to the straight line tool which also applies to the pencil 
and paintbrush. If you press down the Shift key on the keyboard while dragging the 
mouse, only vertical or horizontal lines can be drawn. I used the Shift key feature to 
draw the outline and division of the key. Once you have drawn the outline of the key, 
you can use the Area Fill tool to put in different patterns. 

The Alphabet tool 

Once I had drawn the key, all that remained was to add the names of the area sales 
managers and an overall title for the map. MacPaint gives you the ability to add text to 
your drawings by means of the Alphabet tool. 

On the face of it MacPaint would appear to of fer as many if not more facilities for 
using text than Mac Write provides. MacPaint has an equal number of fonts and style 
options, and it will allow you to use a 72 point font size which is much larger than 
Mac Write from your work disk, it must be said that MacPaint's text editing faci lities 
are much more limited than MacWrite's - once you have typed something in and 
moved off the alphabet icon, you can't go back and alter the previous piece of text. 
Neither does MacPaint have word wrap, and there are no tabs or margin settings. 

The real purpose of having text in MacPaint is not so you can use it to replace Mac­
Write, but so that you can add labels, headings and short descriptions to your dia­
grams. You don't have to worry about large chunks of text since you can transfer 
MacPaint files into MacWrite and vice versa. 

For my sales map, I decided to use the 9 point font size and the plain New York font. 
You position the text cursor in MacPaint in the same way as you do in MacWrite­
moving the mouse to the appropriate position and clicking. 

When you type text in MacPaint, if you press the carriage return , the beginning of the 
next line will be treated as the point from which you startd typing so you don't have to 
worry about your diagrams gett ing overwritten. 
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Deleting text 

As I said earlier, you can only alter text while you are using the Alphabet tool- as 
soon as you move to another tool the text is treated exactly the same as the drawings. 
So if you try to go back and delete some letters by using back space it won't work . The 
simplest way to get rid of text is to use the Eraser and rub it out. Undo will do equally 
well for deleting the last piece of text you typed in. 

The final touch on the map is to add a title. I have called it 'Hadley Engineering Sales 
Areas'. As you can see in Figure 5.9, I chose 14 point for the lettering and I also 
underlined the heading. Once you have added the title to your map it will be complete 
and you can print it. As you print your picture, MacPaint wi ll use Show Page to let you 
see the progress of the printer as it reproduces your drawing on paper. 

Hadley En~ineering 
Sales Areas 

Figure 5.9: Map with Headings 

Jim 

Bill 

Hany C. 

Stew 

Herry H. 

Franlc 

ChriBHN' 

Once you have printed the picture, you should close your file, saving the changes you 
have made. Then you are ready to open a new file and begin drawing from scratch 
again . 

Conclusion 

At the beginning of th is chapter I said that Mac Paint had a huge variety of options and 
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thus far I have covered probably about a quarter of them. Since I have finished des­
cribing how to set up the first example, now seems a good time to pause and take stock 
of what has been covered so far. The I shall talk in the next chapter about using the 
Shape tools. 

The main idea of this chapter was to get some practice in using the tools and, most 
importantly, the mouse. Together they are a formidable combination but it does take 
time to develop a bit of skill in manoeuvring the mouse to the best effect. 

Drawing accurate lines needs quite a bit of concentration although MacPaint does let 
you draw straight lines automatically and will even restrict how the line is drawn to 
horizontal or vertical. Even when you get in a mess, MacPaint gives you plenty of 
opportunity to correct your mistakes and improve your diagrams with Eraser, FatBits, 
Revert and Undo. 

If you have managed to master moving the mouse and drawing lines, you have gone a 
long way towards being able to put Mac Paint to very practical use. 



CHAPTER6 

More About MacPaint 

The drawing tools in MacPaint fall roughly into two categories- those which allow 
you to draw free-form lines and pictures (Pencil, Paintbrush and Spraycan) and those 
which draw rectangles, ovals and polygons. In this second category, drawing is more 
structured -the shape of what is drawn is , in the case of rectangles, predetermined. 
This means that you don't need to be so concerned about the accuracy of the lines you 
draw- the drawing is done for you. All you have to do is concentrate on the size and 
position of the shapes. 

In this chapter, I am going to explore the use of shapes to create diagrams and draw­
ings. MacPaint gives you five separate shape-drawing tools- Rectangle, Oval, Rec­
tangle with rounded corners, free form rounded shapes and Polygons. For each of 
these shape wols you have the option of either filling them with any of the available 
patterns or leaving them unfilled. As well as being able to use patterns to fill the shapes, 
you can also vary the thickness of the border or have no border at all. 

Using the shape tools is drawing a lot of different shaped boxes. This sounds very 
simple as, indeed, it is, but at the same time it offers great potential. A simple rectangle 
can represent many things - it can be the border of card, the walls of a house, the 
outline of a form, part of a machine. Other shapes can have the same significance and 
even though you may not have the same freedom of movement and design as when 
using the Pencil and Paintbrush, you still have scope for drawing diagrams in great 
detail without having to rely too much on artistic ability. 

I am going to begin by looking at the use of the unfilled shapes. The example I am going 
to use is a flowchart. Flowcharts are generally associated with writing computer pro­
grams and that is the example I shall be using. However, they can be useful in general 
problem-solving where you want to make a series of logical decisions taking into 
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account all possibilities. Before I describe how to set up the flowchart, I shall give an 
explanation of the principles and conventions of drawing them. 

find record 

n 

n 
end 

Add 3 to 

Sal~s total 

Figure 6.1: Programming Flowchart 

Drawing a flowchart 

In Figure 6.1 is the completed computer flowchart. The aim in drawing any flowchart 
is to ensure that the computer program written will be logical and will take into account 
all the processes which will occur. In my example, I have taken a file of sales records 
and I want to add 3 units to each sales figure. To do this, I must break the process down 
into steps and then consider a number of factors which are going to effect the program 
I write. The steps involved are: 
(i) Get the records. 
(ii) Add 3 to each sales figure. 
(iii)Finish the process. 
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A number of questions arise which I have to think about: 

(i) What happens if I can't find a record? 
(ii) How will! stop the process when there are no records left? 
(iii)Once I've processed one record, how will I go on to the next? 

The flowchart helps me to map out the processes involved and deterntine how to tackle 
the problem when I start programming. It should ensure that the processes are all 
correctly linked and that I don't get stuck in any dead ends. 

You will notice on the flowchart that there are a number of different shaped boxes 
being used. This is because fl owchart conventions use a different boxes to indicate 
different procedures. These are illustrated in Table 6.1. If you are not familiar with 
them here is a short explanation of the meaning of each one: 

('---~) Terminator 

Decision 

D Process 

"----/ _ 7 Input /Output 

Table 6.1: Flowchart Symbols 

Terminator Box : Although this is called a terminator box it actually serves to indicate 
both the starring and finishing point of the whole process. 

Decision Box: Decision boxes are used for asking the questions. For example in my 
flowchart figure I have two decision boxes one which says 'Found?' the other 'End of 
File? '. To each of these questions there must only be two replies, yes or no. The deci­
sion box is there to determine which way to go depending on the answer. If it is the end 
of the file then you finish, if it isn't you go and find another record. 

Process Box: When you have found the record you want to do something to it. The 
instructions will be held in process boxes, usually with one instructio n per box. 
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Input/Output: This box is used for getting the information on which you are going to 
work . 

There are also conventions concerning the lines which connect the boxes. If it can be 
avoided , the lines should not cross one another. There should only be one line going 
into a box and one going out (except decision boxes where there are two coming out). If 
you send a line back to a box it should join the line going into the box, not go straight 
into the box. For Jines which are looping back there should be an arrow indicating the 
direction of flow. 

The variety of shapes of boxes you can draw makes MacPaint invaluable for 
flowcharts. There is also the advantage of being able to move the boxes around. If you 
have ever had to design flowcharts with a pencil and a piece of paper, you will know 
how messy it can become. You have to rub out and move lines and boxes- often it's 
quicker to start again. 

Let 's look now at how to draw the different types of box. Begin by closing any files you 
may have been working on and select the option New from the File menu to give 
yourself a clean page to work on. 

Terminator box - round cornered rectangle 

The first box in the flowchart is a terminator which, as I explained earlier, is used both 
for the starting and the finishing point of the flowchart. To draw the box, you need to 
select the unfilled rounded rectangle tool. To allow any shape you must drag the mouse 
on the window in the direction you choose. As you move the mouse back and forth the 
shape will enlarge and contract so that you can adjust its size and shape until you are 
satisfied. Then you can release the mouse. 

For the terminator box, you need a long narrow rectangle . When you are drawing it, 
you must remember that the point at which you start dragging the mouse will form one 
of the corners of the box so you must make sure of your positioning before you start. 
Remember, however, that you can always Undo your mistakes and start again . 

Input/ Output- polygon 

The input/output box is a parallelogram and to draw it you need to select the unfilled 
polygon tool. Once you have selected this tool, you need only click on the mouse to 
start drawing lines, you don't need to drag the mouse. Click on the mouse each time 
you want to change direction. When you close the parallelogram, MacPaint will stop 
drawing. If you don't close it accurately MacPaint will continue to draw the line. To 
stop it doing this, double-click on the mouse. As with any of the tools, you can use 
FatBits to make alterations to your shapes if necessary. 
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Process box- rectangle 

The process box Is very straightforward to draw- it is a simple rectangle. As with the 
rounded rectangle, the starting position of the cursor forms a corner of the box and 
you can drag the box in any direction for any distance until you get the size and shape 
of box you want. 

Decision box- polygon 

You need a diamond shape for the decision box and this, like the input/output box 
can be created with the polygon tool. The polygon tool will only draw completely 
straight lines vertically or horizontally so, for the diamond, the lines may appear 
slightly crooked. 

Making copies 

On the flowchart there are two of each type of box with the exception of the parallelo­
gram. Rather than draw a second box, it is possible to make copies of the boxes you 
have already. This has two advantages, not only does it save on time on drawing, but it 
also gives more uniformity to the diagram -the boxes don't end up being slightly 
different sizes and shapes. 

To make a copy of a box you need first to select it. If you remember in MacWrite, 
selecting text was done by dragging the mouse across sections which were then 
highlighted. A similar principle applies in MacPaint but since the drawings are not 
always of such a regular shape as lines of text might be, selecting them is dealt with in a 
slightly different way. At the top of the tool chart is an icon of a rectangle with a dotted 
outline. This is the Selection tool. Choose this tool and move onto the window. The 
cursor will have become a cross made up of a dotted line. Position it near one of the 
boxes you have drawn and drag across the box. You will find that the border of the box 
you have selected will be a moving dotted line. This is to indicate that what is inside it 
has been selected and can be moved, copied, or deleted. 

Now go to the keyboard and press down the Shift and Command keys together. At the 
same time position the mouse arrow inside the selected box and drag it. As you drag 
clear of the original position, you will find that a copy of the box has been made. 

Continue to drag the box until it is in the correct position in the flowchart. Repeat this 
process with each of the boxes you want to duplicate. Be careful not to release the 
mouse as you are dragging it or you will find yourself with more copies than you had 
bargained for. 
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Text and Lines 

Once you have your boxes in position, you need to add text to the boxes and join them 
up. Entering the text simply requires using the Alphabet tool and typing inside the 
boxes. To join the boxes, you can use the Straight line tool or the Pencil and to ensure 
that the lines a re absolutely straight draw them while holding down the Shift key. 

When you are using a line to indicate that the process loops back on itsel f, the line 
needs to have an arrow on it to indicate in which direction of flow. 

On the lines coming out of decision boxes there must by a 'y' and an 'n' to show which 
way to go according to whether the specified·condition is true or false. 

Making changes 

Since I designed the flowchart , a new condition has arisen which I must take account 
of. If the sales f igure is already over 100 I don' t want to add to it. So when I write the 
program I must test for this before I add 3 to the sales total. This also needs to be added 
to the flowchart, so I must make an appropriate alteration. 

Lasso 

When you copied and moved the boxes to create the flowchart, you used the Selection 
tool to specify which box you wanted. The Selection tool is useful when you want to 
select fairly regular shaped areas of the drawing, but in this case I want to insert a new 
box between the 'found' decision box and the process box which says 'Add 3 to sales 
total' . To do this, I must not only move the process box but also the lines attached to it. 
I am going to use the Lasso. 

Lasso allows me to draw a line around the area I want to select. When I have done this 
the edges of the object are traced with a moving line. Lasso is much more precise than 
the Selection tool about what is selected, but it provides fewer facilities. 

To move the process box and lines, select the Lasso tool and draw a line around them. 
A moving dotted line will replace the normal outline of everything inside the area you 
lassoed. You can now use the mouse to drag the lassoed area downards. Once the new 
box has been added you will want to rejoin the lines. 

To make sure that they are still correctly aligned, press the Shift key while you move 
the box, which will ensure that you will only be able to move it verticaJiy downwards. 

Figure 6.2 shows the finished flowchart with the new decision box added. The process 
now checks whether or not the sales total is over 100 before adding to it. If it is, the 
process will loop back to look for the next record . 
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n 
found? 
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Sales total 

Figure 6.2: Flowchart with added decision box 

When the flowchart is complete you can print it out. It is a simple guide to writing a 
program or making decisions. The secret of a good flowchart is to keep it simple - if 
you have a mass of boxes and lines going in a ll directions, the flow becomes very hard 
to follow. 

Filled Shapes 

Joanna Davies was successful in her application for the job of Warehouse manager at 
Hadley Engineering. One of the first things that became apparent when she started the 
job was that the warehouse had become very disorganised over the years. Shelving had 
been added haphazardly and the whole place is now in a mess. To improve the 
situation, Joanna is going to put forward a reorganisation plan for the warehouse 
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using the existing shelving as far as possible. She has used MacPaint to draw up a plan 
of the new organisation. To illustrate her point she has drawn a plan of the existing 
layout of the warehouse and she is going to use MacPaint to manipulate the shelving 
and produce the new layout from the same shapes. The contrasting plans are 
illustrated in Figure 6.3. 

Current Warehouse layout 

::J i -

Proposed Warehouse layout 

Figure 6.3: Warehouse Layout 

Drawing filled shapes is the same as unfilled ones except that the shape you draw will 
be filled with whatever pattern is currently selected. This will cover anything beneath it 
(the hollow shapes will leave any shapes below visible). 

Joanna's warehouse diagram is a hollow rectangle containing a number of filled rec­
tangles representing the warehouse shelves. She is going to take the original 
hotchpotch of shelving and rearrange it so that it looks like the second diagram in 
Figure 6.3. If you want to follow this example, draw a copy of the first diagram and 
then follow the description set out below. 
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Rearranging the shapes- select and rotate 

Moving the shelves on the drawing is a question of selecting them individually and 
repositioning them. There are two things to be considered when doing this. The first is 
to be careful, when selecting the individual shapes, not to leave a gap between the 
border of the shape and the selection box. If you do, the gap will be moved as well and 
you will find yourself overlapping with other shapes in order to get them close to­
gether. Secondly, some of the shelves will be the wrong way up to fit in to the space 
available. You need to use Rotate to change them. Rotate is an option on the Edit 
menu. It is only effective when an item is selected and it is used to turn the selected area 
90 degrees to the left each time you choose the option. 

On the Edit menu you will also see the options Flip Horizontal and Flip Vertical. Each 
of these will move a selected shape by flipping it over either from one side to the other 
or from top to bottom. 

Another example of the use of MacPaint is to decide on an office layout. It is often 
very helpful to have a drawing in which you can manipulate the furniture to visualise 
what the office will look like with different layouts. By using MacPaint it is possible to 
draw the office and the pieces of furniture you want to use, and then produce several 
copies of the picture rearranged in various ways. 

Getting the dimensions right 

One of the problems you may encounter if you use MacPaint in this way is how to get 
the proportions and dimensions of the shapes right. The easiest way of overcoming 
this problem is to make use of the Area Fill tool and the two checked patterns. Before 
you begin drawing you should select the large check pattern and the Area Fill tool. You 
should then fill the blank screen with the check pattern. This will then act as a grid for 
you to work with. You can then use filled shapes (remember that if you are using the 
filled-in shape options, you can fill the shapes with plain white if you want to) on the 
grid. 

To illustrate this , let's take the example of arranging the office furniture. (See Figure 
6.4.) I filled the window with the checked pattern. I then drew a white filled rectangle 
to the size I wanted to represent the office space. The office dimensions are I Oft by 20ft 
and I allowed two squares per foot. I intended to put two desks, a filing cabinet, a 
cupboard, a telex machine and a bookcase in the office. So that I could easily gauge the 
dimensions of the furniture, I drew each piece outside the area I designated for the 
office, and then moved it inside. 

If I had wanted to achieve even greater accuracy in the sizing of the furniture, I could 
have used the smaller check pattern to draw it. This can be particularlyusefui if you are 
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Figure 6.4: Office Plan 

trying to arrange a room with a limited amount of space where actually fitting in all the 
furniture may be more important than the aesthetics of the layout. The only obstacle I 
have taken account of in my drawing is the door into the room, but you would prob­
ably also have to consider the position of radiators, windows and power and telephone 
points. 

Additional Shape features 

I have already covered most of the basic shape features in MacPaint and I have also 
looked at Rotate. In this section I am going to explore a few more of the combinations 
which you can use to produce interesting effects. If you look at Figure 6.5 you can see 
three examples of logos for Brooks Disks. I have combined several features to achieve 
the effects and I shall be looking at these here. 

Figure 6.5 (a) is an example of using the Invert feature of the Edit menu. Its function is 
to reverse the colours of a selected area so that the white area becomes black and the 
black becomes white. To create the logo, I typed in the words Brooks Disks in 24 point 
Venice font with italics . Then I drew a rectangle around them which 1 filled with a 
black on white dot pattern. The final step was to select the area and invert it to create 
the effect you can see in the figure. Invert will let you change the black on white, white 
on black combination as often as you like. 

Figure 6.5(b) introduces several features of MacPaint. I have drawn an oval around 
the words with a thick patterned border. To get a patterned border you have to press 
the Option key down as you are drawing the shape. The border must be one of the 
thicker ones in order to achieve a good effect. With the narrow border you will usually 
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(a) 

(b) 

(c) 

Figure 6.5: Company Logos 

end up with just a dotted line, because it is too thin to show the full pattern. I drew the 
rectangle outside with a thick black border and then filled the space in between the two 
shapes. 

Figure 6.5(c) is the same picture as (b) except that I have used the option Trace Edges 
from the Edit menu to alter its appearance. Trace Edges gives you the outline of the all 
the lines you have drawn and the centre part wi ll be turned white. 
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Conclusion 

If you consider how MacPaint works, you will see that it revolves around the arrange­
ment of black dots on a white screen, and the ability to add, move or remove those 
dots. Different combinations of dots and different ways to add and remove them 
provide you with the tools to create an endless variety of drawings from the most basic 
doodle to complex technical diagrams. 

Learning to use MacPaint effectively takes time, especially if, like me, you have no 
particular drawing skill. Yet I have found that by using the more restricted MacPaint 
tools (those I have looked at in this chapter), you can create useful designs without 
having to rely on freehand drawing. 

Let's recap on what has been covered in this chapter. You have seen how you can draw 
shapes as opposed to just lines. These shapes are automatically drawn for you to a size 
that you determine. You are able to alter the thickness and border of the shape you 
draw, and you can fill it with any pattern you choose. Once you have drawn and 
coloured the shapes you can move them about the screen, turn them on their sides or 
upside down, make copies of them. Not only are all these things possible, they are easy 
to do. The majority can be accomplished with one or two actions- select a pattern, 
select a tool and off you go. 



CHAPTER 7 

Applications using MacPaint 

By now you should have a good idea of how Mac Paint works. This chapter aims to give 
you further ideas for its use. 

ln this chapter I am going to talk less about how to use MacPaint and more about the 
different types of application it is suited to. Clearly it is for drawing. You have already 
seen a variety of diagrams and pictures and you have has ample practice in creating 
them for yourself. However, there are some specific areas where including illustra­
tions and diagrams is particularly appropriate, and I have chosen several of these to 
look at in detail here. Each section is illustrated with examples for you to draw and I 
shall be giving details of any particular features of MacPaint not already covered in the 
previous chapters. 

Illustrations for advertising 

For many people, a common place to advertise is in newspapers or periodicals. Mac­
Paint is an ideal way to set up illustrations for this type of advertisement. Often the 
print quality in newspapers is poor. Illustrations are usually black and white drawings. 
You have seen the way MacPaint works, so you will realise that it is very well suited to 
this type of drawing. In this section I am going to use an example of one such adver­
tisement. 

Everglaze Windows often adver tises in local newspapers and likes to illustrate the 
advertisements with pictures of the types of windows it sells. Figure 7.1 is an example. 
Below I have described how to produce it in MacPaint. 

Leaded lights window: The basic window consists of unfilled rectangles. Having 
drawn them, I used the Trace Edges option of the Edit menu to give a double line round 
the edges. 
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Figure 7.1: Advertisment. 

To get the criss-cross pattern, I had to use Edit Pattern because there is normally no 
diamond-shaped pattern available. Edit Pattern can be accessed by double-clicking on 
the pattern you want to change . In this case, I took the wide diagonal line pattern and 
added a diagonal line in the opposite sense. Once I had created my new pattern I filled 
the window frames with it. 

Georgian style window: Inside an unfilled rectangle I drew one smaller rectangle which 
I then copied to represent each separate pane of glass. I copied the rectangle by 
selecting it, and then dragging it while holding down the Option and Shift keys. This 
ensured that the panes of glass would be correctly aligned. 

I used the polygon tool to draw the open window at the top . Again I pressed the Shift 
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key before starting to draw so that the lines would be only at 45 or 90 degree angles to 
one another. 

To achieve the shadow under the open part of the window I used Area Fill. Finally, to 
give the illusion of glass in the windows, I used the Brush and diagonal line pattern to 
draw some lines on the window panes. I repeated this effect on the door as well. 

When I drew the house, I thought that a complete brick pattern would look over­
powering, so instead I used the Spraycan and the brick pattern to give a lighter impres­
sion of brickwork. On the roof, I used the tile pattern which MacPaint provides and 
then I added the writing afterwards. I have found it best to add the text later because 
the lettering will then create its own clear space. 

The wording at the bottom of the picture is in Geneva fo nt point size 18 with embol­
dened style and middle alignment. You need to be careful when using the middle 
alignment because, unlike in MacWrite where the margin settings determine the 
middle point, the point around which the text is aligned in MacPaint is that which you 
determine by positioning the cursor. You must also make sure that the text does not 
disappear off the edge of the window. If it does, it is not retrievable and you may find 
you will have to retype it. 

For the bottom two lines I added outline and shadow to the style selection and then 
when I had typed them in, I selected and inverted them. 

In designing this advertisement I found that one of the most useful features was being 
able to use the Shift key to restrict the movement of the mouse with various tools so 
that I could be sure that the lines I drew were straight and at the correct angle. The Shift 
key works with nearly all the MacPaint tools. I have listed how it works with the 
various tools below. 

Shift key- restricting the MacPaint tools 

For restricting lines, the shift key works in two ways- with Eraser, Spraycan, Brush, 
and Pencil it will only allow horizontal or vertical lines to be drawn. With the Straight 
line and Polygons, only 90 and 45 degree lines can be drawn. 

As well as constraining line drawing, Shift will let you move the window only horizon­
tally or vertically with the Hand. Any selected item can likewise only be moved in those 
two directions. 

As far as rectangles and ovals are concerned, Shift lets you draw only squares or 
circles. In fact the only tools not affected by the shift key a re irregular rounded objects 
and text. 
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When you use the Shift key it needs to be pressed only once before you start drawing a 
line and it wi ll continue to be effective until you release the mouse keypad to start 
another line. Once you have started drawing a line with the Shift key in force, the line 
will continue on the same path regardless of where you drag the mouse. This is very 
convenient if, like me, you fi nd it hard to keep lines going exactly straight. 

Diagrams to replace words 

There seems increasingly to be a trend away from giving written instructions and to­
wards giving instructions in pictorial form - the Macintosh itself is a prime example. 
All kinds of signs and sets of rules use fewer words and rely more on pictures. 

Packaging symbols 

For my first example of replacing words with pictures, [ have reproduced the parcel 
handling symbols that are commonly seen on boxes. (Figure 7.2) To draw each 
symbol, 1 used the shape tools. 

Figure 7.2: Packaging Symbols. 

For the g lass and the umbrella icons, r first drew a circle with the oblong tool and Shift 
key. Then I drew a straight line across the circle and erased the half [didn't want. [ 
found this was a much easier method of getting a curved line than drawing it freehand. 

Fat Bits was also a great help to get rid of unwanted lines between the different shapes . 
Although it may seem tedious to have to erase or add dots one by one, in fact it can be 
quicker than relying on steadiness of hand to erase sma ll areas using the rather cum­
bersome eraser. Remember also that you can use Eraser in Fatbits to rub out indi vidual 
dots and you can restrict movements in Fatbits by means of the Shift key. Once I was 
satisfied with the symbols themselves, I selected each one individually and inverted 
them. 

Now if l want to send any fragile objects through the post, l have the necessary sym­
bols to fix onto them. 
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Cassette deck 

As well as being easy to understand, pictures can a lso reduce the space and time used 
for giving explanations. The example of the cassette deck diagram is a case in point. I 
chose the cassette deck as an illustration to show how you can draw complex-looking 
picture very easily in MacPaint. If you look at the diagram of the cassette deck as 
illustrated in Figure 7 .3 you will see that a lthough it contains a lot of detail, it is in fact 
made up entirely of regular shapes which can be drawn very quickly . It is really a set of 
rectangles and squares drawn inside one another and then labelled. Fortunately, many 
modern deisgns are built with smooth lines and few frills so that producing diagrams 
of them is much simpler. 

powt'r 

hE> ad 
pho!ll'S 

Visual aids 

cassette holder tape counter input selector tuni~ 

000 

record rewind fast play stop pause- volume 

forward 

Figure 7.3: Cassette Deck. 

Training courses for business people are becoming lucrative business, particularly in 
the computing field . Participants expect to be entertained by a stream of changing 
pictures, flashing lights, music a nd so forth. Macintosh is very well suited for produc­
ing the types of visual aid that have become part o f many courses and seminars given 
on a range o f business topics. 

From my own experience I know tha t producing visua l aids can be very t ime­
consuming. In this section l am going to talk about using Macintosh to produce the 
kind of diagram that you can transfer onto a n acetate sheet for use on an overhead 
projector. These types of diagram can also be reproduced into training manuals. 
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The course lam going to use as an illustration is called 'What is a computer?' and the 
diagrams form a series of steps which build into a picture of a full computer system. 
(See Figure 7 .4). 

Central 

Processing 

Unit 

I 
ITbe ·engine· of the I 

computer 

Figure 7 .4(n): The CPU. 

Memory 

Central 

Processing 

Unit 

Temporary storage 
area for information 
being processed 

Figure 7.4(b): Memory. 
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for programs and 
data . Disks or tape 
are often used . 

Figure 7 .4(c): Mass Storage. 
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Input 
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the computer. 
Usually a VDU 
or a printer . 

Figure 7.4(d): Input/Output Devices. 

The diagrams are all straightforward - each consists of simple rectangles with a 
shaded box surrounding it. Further shaded rectanges join one to another. The arrows 
indicating the flow of information were the most difficult. I created these by drawing 
one arrow and copying and rotating as necessary. I positioned the arrows by using the 
Lasso rather than Selection, so that there would be no empty area around them. 

Once you have designed your diagrams you can print them directly onto acetate. This 
saves the intermediate step of having to photocopy the drawings onto the clear sheets. 

With MacPaint you a lso have the advantage of being able to make alterations so that 
the diagrams prepared for one course or lecture can be modified for another. If the 
course is to be taught by several people the diagrams can be introduced into notes on 
how to teach the course so that future teachers know how to use them. Indeed, the 
possibilities are endless. In chapter 8 I shall be looking at how you can merge Mac Paint 
drawings into Mac Write documents. 
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Forms and charts 

One of the problems with many word processing packages (as opposed to dedicated 
word processors) is that it is not possi ble to rule vertical and horizontal boxes. Often 
you have to draw them you rself, afterwards. This does not a lways produce satisfac­
to ry results, and if a particular form is to be sent to someone else it doesn ' t always 
create a good im press ion. Bearing this in mind, I have devised a couple of examples 
using MacPaint to overcome these shortcomings and produce presentable al ter­
natives. 

Holiday p lanner chart 

In the Hadley Engin,eering warehouse, Joanna Davies has to work out a holiday chart. 
(In the first two weeks of August she may need to take on extra sta ff). She also wants to 
use the chan to evaluate holiday requests. Figure 7.5 is the first cha rt she drew up . 

Figure 7.5: Holiday Cha rt. 

To set up the chan and to ensure that the boxes were evenly sized I began by putt ing a 
border round the edge of the window. I filled it with a checked pattern . By doing this , I 
was able to use the small squares to get the spacing between the lines exactly equal. 
Then I used the Straight li ne tool to draw the grid. Alt hough Mac Paint does provide a 
grid fac il ity on the Goodies menu, it is more d iffi cult to work with . 

I have only shown the chart for 14 days in my example since this fitted into the window 
conveniently. However there is nothing to stop you selecting the whole window 
(double-cl ick on the Selection box), and then taking a copy of it (Copy option of the 
Edit menu) wh ich you can move to another area of the page. 
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In general this type of chart has a great many uses . Here I used it for a holiday plan but 
it is equall y useful for producing timetables , time sheets, mileage charts and so on. As 
always with such things the drawback is that it does take time to set up . There is the 
advantage, however, of being able to use the same structure over again. 

Job application form 

In the past I have often had to fi ll in poorly-designed job application forms, where 
prospective employers want you to write your life history in a space the size of a 
postage stamp. Designing a form on the Macintosh gives you scope to experiment with 
the size and content of the form . In addition, it allows you to create different forms for 
different types of job. If, for example, educational qualifications are not important, 
then you can cut down the space allotted to such deta ils. MacPaint can give you great 
flexibility, to prepare an application form suited to the job. 

Figure 7.6 is an example of an application form for a job at the Hadley Engineering 
warehouse. In designing it J made considerable use of the Straight line tool , the Hand 
and the Show Page facili ty. Although there was nothing complicated in the drawing, I 
found that the window size was rather restrictive, so I had to keep moving the window. 
As I drew, I also referred frequently to the Show Page option to see how the whole 
thing looked . When you use Show Page as well as being able to reposition the window, 
you can also move the whole picture around on the page. You do this by putting the 
arrow outside the window area and dragging. This will pull the whole picture in any 
direction . One thing you must be careful of, however, is not to pull the picture off the 
edge of the page as this will erase the picture for good - this is one point where 
MacPaint doesn't offer you a second chance. 

As a final test I printed out the form .and filled it in to check that there was enough 
space in each of the boxes for the details requested. It is also helpful to fill in a copy of 
the form to make sure that the questions you ask are clear and unambiguous. If you 
have devised a form for obtaining particularly complex information it often wonh 
including a completed copy of the form to act as guideline. You could create a com­
pleted copy in MacPaint. 

Conclusion 

When I first approached MacPaint I looked on it with a degree of scepticism. The 
manual and Scrapbook showed me marvellous pictures of Japanese girls and realis­
tically scaly fish. I thought these were impressive but certainly beyond the limits of my 
artistic talent. I feared I had landed myself with an expensive doodling toy. 
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I' m pleased to admit that I was wrong. I looked at the everyday articles around me and 
saw that many of them contained drawings, pictures, diagrams. Articles that I used a ll 
the time, some of which I bought, some of which I needed to produce myself. These 
were all fertile ground for creating examples o f practical ways to use MacPa int in 
business and I have exploited them in the past three chapters. I make no apologies for 
this as my aim has been to show that MacPaint is not a computer-orientated artist's 
tool, it is for people whose talents lie in the commerical world and who need a practical 
business tool. 

In these chapters you have seen how MacPajnt works , how to use it yourself and some 
o f the things you can use it for . I've shown you a number of different areas where you 
can use Mac Paint to create your own designs. 



CHAPTERS 

Integrating Mac Write and MacPaint 

In this chapter I am going to be talking about how to transfer pictures from MacPaint 
to Mac Write. I shall also be giving you some examples of when it is best to use this 
technique. 

Transferring from MacPaint to MacWrite 

As I discussed earlier on, a lthough it is possible to use text in MacPaint, it does not 
offer the range of faci lities of text editing and formatting which are avai lable in Mac­
Write. Therefore if you want to combine pictures with text it is better to transfer your 
pictures into Mac Write than try to set up the text with MacPaint's limited faci lities. 

In C hapter 7, I suggested some instances where introducing MacPaint diagrams into a 
Mac Write document could be useful. One of the examples I gave was that of incorpo­
ra ting diagrams set up for overhead slides into the training manuals accompanying a 
course or seminar. I am going to look at this example in more detail now and show you 
how to move diagrams from MacPaint into MacWrite and make alterations to them. 

Take a look at Figure 8.1. In it, I have reproduced part of a page from a training 
manual set up to accompany a course called 'What is a computer?' The text of the page 
is interspersed with some of the diagrams created in chapter 7. 

Drawings can be introduced into MacWrite by two means. One is directly via the 
C lipboard in which case you make a copy of the drawing you want to transfer and then 
swap straight to the MacWrite document and Paste it in. This has the advantage of 
speed but the disadvantage of being able move only one picture at a time. This can 
become very tedious, particularly if you only have one disk drive and programs and 
files stored on separate disks. The al ternative is to use the Scrapbook. This is slower 
than using Clipboard, because the drawing must first be selected and copied; then 
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one of the most important parts of a computer is the central Processing 
Unit (CPU for short). This is the component which does all the won. As Its 
name suggests it processes any information you give to work on. This work 
may be doing calculations, making a copy of a file, printing out a document 
and many other tasks. Each of these jobs will be handled by the CPU. You 
can think of the CPU as the engine of the computer. 

The CPU processes information in small chunks, it would not take a whole 
file of information at once as It does not have room for il Another 
component of the computer takes care of storing the information wh)le the 
CPU gets on with the actually item by item processing. This component is 
ca11ed Memory. 

Memory 
Temporary storage 
area for information 
being processed 

Figure 8.1: Noles on 'What is a computer?' 

Scrapbook must be opened and the drawing pasted into it. Scrapbook will , however , 
keep a permanent copy o f each diagram you copy to it , so the drawings may be used 
more than once. 

Which ever method you use, once the drawing has been selected and copied, you then 
need to close MacPaint and open the MacWrite document. You can then paste the 
drawing where you want it. For the sake of speed, I would say it is better to put the 
diagrams in as you go a lo ng, otherwise you spend a lot of time scrolling backwards and 
forwards to get the cursor in the right posi tion. 
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The area of the diagram is not actually accessible for adding text. If you try to position 
the cursor near the drawing, Mac W rite will respond by drawing a box round it similar 
to the Selection box that you drew in MacPaint (see F igure 8.2). This box has several 
uses. 

I I , Temporary s torage 

I 
Memory _ area for information 

bemg processed 

I -
. 

Figure 8.2: MacPaint diagram in MacWrite 

(i) Changing the position of the drawing on the screen- you do this by putting the 
arrow right on the outside line a nd dragging the box either to the left or the right. 
It is not possible to move up o r down. 

(ii) Altering the size of the drawing- on the bottom line of the box are three small 
black squares. If you put the arrow on one of these boxes and drag it the shape 
a nd size of the picture will change. This can be helpful if you want to use a 
diagram which was originally quite large and for space reasons needs to be con­
densed in the text. (Figure 8.3.) 

Memory 

r-

lemporary storage 
I-- area for information 

b~ing processed 
-

Figure 8.3: Condensed MacPaint diagram 

(iii) Copying, moving or deleting the diagram - when the box is in place, the dia­
gram can be cut, copied o r pasted in the same way as you would do in MacPaint 
with the Selection box o r with highlighted text in Mac W rite 

The box will disappear when you click on the mouse outside the border of the box and 
you can resume norm al editing. 

Apart from moving the MacPaint diagrams across the screen and changing their size, 
it is not possible actually to edit the picture itself. Similarly, if the diagram has any text 
attached, you will not be able to a lter it , either. You will find tht the full width of the 
screen is inaccessible where you have put the diagram. T his means that if you want tO 
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pow..r 

tLted 

pt..ones 

casseH• holder lope count•r · 

rer,ord revrind fast play s top pause 
forward 

Instructions 

input sd•clor tuning 

volutrU> 

1. Plug in Ule cassette recorder and switch it on by pressing Ule button 
marked Power. Wait a few moments wbi.le Ule recorder does its 
self-test. 

2. Press the button marked 'tape' to indicate you want to use Ule cassette 
player. 

3. Open Ule cassette player door by pressing Ule eject button. The door 
will open slowly by itself, do not try to force it open. 

4. Take the cassette you want to play out of its case and, with exposed 
tape end pointing downwards, put it gently into Ule cassette player. 
The tape will be spooled anticlock.wise (left to right) so the lefUland 
spool should be full when you start playing it. 

'· 

5. Having inserted Ule tape, push Ule door closed gently. Do not attempt 
to start playing it unW tlle door is completely closed. 

6. Push Ule button marked play on tlle diagram above to begin listening 
to tlle tape. 

Figure 8.4: Instructions for operating a cassette deck 
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add any notes to the side of the diagram or if you want to label it, you must do it in 
Mac Paint before transferring it. 

Anot her limitation is that you can move the pict ure only as a block. You cannot select 
individual parts of it as you can in MacPaint. So if you want to use different parts of a 
picture as separate items, you will have to move them separately. 

Some applications integrating MacPaint and MacWrite 

Instructions 

In chapter 7, I talked about using M acPai nt to produce diagrams to replace written 
instructions. It is possible to condense and simplify instructions considerably by using 
symbols . There are, however, occasions where diagrams alone do not convey enough 
in formation to be fu lly understood. In such instances, the diagrams act to complement 
1 he written instructions but cannot entirely replace them. 

Using a combination of diag rams and written instruc tions is common for e lect rica l 
applia nces. 

' I o illustrate how to set up these types o f instructions, I have deliberately chosen a 
simple a nd fami lia r example - using a cassette recorde r (Figure 8.4). I chose this 
because although it is famili a r, it reveals a n important point about writing any kind of 
inst ructions- yo u mustn't forget the basics. It is easy to plunge straight into the 
seemingly complex part of an operation, forgetting the necessary but simple s teps 
leading up to it. 

Notices 

MacPaint a llows you to use much larger le ttering than Mac Write , 72 points compared 
wi th 24 points. This means that in cases where part icularly p rominent lettering is 
necessary to draw people's a ttention to a notice, it can be convenient to type the 
heading in Mac Paint and then transfer it into MacWrite where you add the rest of the 
text. This is the method I used in devising the notice illustrated in Figure 8.5. 

MacWrite to MacPaint 

While it is possible to move text into MacPaint fro m Mac Write , this fac ility is limited 
to the a moum of text which will fill t he MacPa int window. If you try to transfer a 
lo nger piece of text , the pa n which lies outside the window will disappear. This means 
that bringing in text is laborious and po intless, since is it as easy to transfer the other 
way. 

105 



MASTER YOUR MACINTOSH SOFTWARE 

106 

i-.i]·=·P. 
·-· ·- ·-· ·-· .. -.~r· ·-· 
FIRE 

l. If possible, raise the alarm and inform your supervisor. 

2. Do not attempt to tackle the fire. 

3. Leave the building by the nearest exit. 

4. Do not stop to collect your personal belongings. 

S. Report to the designated meeting point for your area of the factory 
and wait there until a roll -<all has been done. Please do not leave 
until this has betn done. 

6. Do not reenter the building until you are told it is safe to do so. 

Figure 8.5: Fire Notice 

Conclusion 

MacPaint gives you great flexibility in drawing diagrams and adding text to them. In 
size of lettering it has even better facilities than Mac Write. It does, however have only 
limited text editing facilities, so there are occasions when transferring diagrams to 
Mac Write can be an advantage. These occasions are usually when you want to include 
illustrations in a long text document. 

Although it can be convenient to make the transfer, there are some restrictions on 
doing so. First, once transferred the a rea occupied by the diagram is not accessible, 
except for moving and changing the size of the picture. The diagram cannot be la rger 
than the size of the MacPaint window, because this is the largest area which may be 
selected in MacPaint and so copied to the Scrapbook. 

Transferring can be a very effective way of introducing illustrations into text docu­
ments and thus making them more interesting and more informative. 



CHAPTER9 

Closing remarks 

I am going to use this chapter as a summary of the key features of The Macintosh and 
MacPaint and Mac Write. I shall give some general rules about using them. 

Macintosh 

Macintosh is an enjoyable machine to use. Once you get the hang of the mouse and 
icons you can move around quickly. They are consistently used in Finder, MacWrite 
and MacPaint so once you have learnt the principles it is not difficult to apply them to 
the different packages. When writing this book, very little of the promised software 
(MacProject, MacBasic, MacLogo etc) had been released, but if they follow the same 
pattern as MacPaint and Mac Write, the first hurdle of getting familiar with the basic 
tools should be very easy to overcome. 

Disk limitations 

I have a Macintosh which has one integral disk drive. I find this put a number of 
restraints on the use of the machine. 

Finder, MacPaint and MacWrite take up a large portion of the Write/Paint disk. 
This means that most of the files you create have to be stored on anoth.er disk. With 
only one disk drive, this means a considerable amount of swapping backwards and 
forwards between disks whenever you want to open or close and save a file. 
Admittedly, Finder does most of the work for you, but the time it takes does cause 
irritation, particularly when you want to copy several files from one disk to another. 
Unfortunately there is no way round this. 

The limited space on the disk means that, on occasions, I am confronted with ames­
sage telling me that the disk is nearly full and that I will have to delete some files if I 
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want to continue. This happens most often in MacPaint which demands something in 
the region of 35 to 40k of disk space in which to operate. This can be quite aggravating 
because the Macintosh will then close my file for me whether I want to or not. This has 
made me very space conscious. Here are several ways -to economise on space used on 
the Write/ Paint disk : 

1) Clear out any unused items from Scrapbook- it is a real space hog. The examples 
provided are interesting to look at but I hardly ever use them. 

2) I don't use the Notepad File which is provided on the disk sol deleted its contents 
-I find that just looking at it creates a fi le which used up 2k of precious space. 

3) Finder itself provides you with a method of clearing space - the Font Mover. Most 
of the time I stick to straightforward Font styles and save the others to a separate 
file where they take up less space. 

4) Delete the sample files which came on the Write/ Paint disk. 

Although the space saving is meagre , it is often the difference between having to stop 
and being able to keep going. The problem of space has also made me decide that an 
additional disk drive is really a must if you want to use the machine and your time most 
efficiently. 

Finder 

Unlike many operating systems, I find that not only is Finder very easy to use (again 
thanks to the mouse and icons) but very robust. By that, I mean that it very seldom 
gives out on me. In fact , there have only been two occasions. On both occasions, it was 
clear what I had done wrong and I was given the chance to start again immediately. 

Mac Write 

Mac Write's main strengths are that it combines all the features you would expect of a 
word processor with the additional benefit of being able to vary the size and style of 
lettering. Most of what you need is on the screen or easily accessible in menus. You can 
save your energies for typing documents rather than hunting through a manual to find, 
say, the underline key combination . Any function which is not immediately visible on 
the screen wi ll usually be presented through a series of dialogue boxes giving you the 
available options once you have chosen a facility from the menu. 

Editing 

The Edit Menu is consistent in Finder, Mac Write and MacPaint. The select, cut , paste, 
copy procedures are standard and contain several safeguards. In MacWrite, for every 
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editing option there is also the possibility of undoing it and then redoing if you choose. 
Not all word processors are so forgiving. 

As well as having menus to work , with Mac Write lets you use all kinds of shortcuts on 
the keyboard to give you access to the editing options. In fact, I find that I don't use 
these very much as it is just as quick to use the mouse. 

Font and Style 

Although most of MacWrite' s facilities are fairly standard, Font and Style are two 
features which make it extraordinary. The usual range of word processing style 
options extends to under-lining and emboldening. Mac Write additionally offers out­
lining, italics and shadowing. Different fonts and letter sizes are also exceptional 
features of MacWrite. Having these available expands the range of applications so 
that you can be more imaginative in writing standard documents, and design docu­
ments and text that ordinarily would not have been possible. Letterhead and adver­
tisements are examples. 

Other Features 

The facilities available in Finder are a lso useful in MacWrite . In chapter 4 I showed 
you how to use the Scrapbook to keep a standard paragraph, how to use the Calculator 
to do the sums for an invoice, and how to use the special characters to write a letter in 
French. 

None of these features is unique to MacWrite as a word processor, but the ease with 
which you can use them is certainly untypical. MacWrite actually shows you these 
features on the screen, you don't have to hunt for them or stumble on them by 
accident. 

1 find one of the best features of MacWrite is that learning how to use it is actually 
enjoyable. Usually getting familiar with a new package involves a considerable 
amount of frustrated effort as you struggle with unhelpful instructions. 

MacPaint 

At first sight, MacPaint is a very unusual and apparently unbusiness-like package. 
That it does not deal in columns of figures or 50 page management reports makes it 
seem rather frivolous. It is hard to imagine business people wasting their time drawing 
pictures with a sophisticated etch-a-sketch toy. 

These prejudices were compounded when I first started to use MacPaint and found 
that my first efforts were not much more than doodling. 
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It does not take long, however, to realise that diagrams and illustrations play a big part 
in many areas of business. Advertising relies heavily upon them, technical information 
and instructions are clarified with diagrams and symbols and signs are increasingly 
taking the place of words in giving information. Looked at in this light, MacPaint 
becomes a much more useful tool and can be used to create diagrams which don't 
require a lot of skill in drawing. 

Tools 

To use the MacPaint drawing tools most effectively you need some practice with man­
oeuvring the mouse. Once you have mastered that it gets easier. As I discussed in the 
chapters on Mac Paint, the tools fall into two broad categories- one for free form line 
and shape drawing and the other for drawing more controlled, regular shapes. The 
second of these proved to be the most useful. 

Creating different shaped and patterned boxes is really the key to get the most practical 
benefit from MacPaint. Most of the examples I used in this book depended largely 
upon drawing rectangles and oblong shapes. I also used the straight line tool exten­
sively and of course the Eraser. 

Using MacPaint becomes easier once you realise that everything you draw is made up 
of small black dots which, by using the FatBits facility, can be manipulated individ­
ually. This means that you can make your diagrams very accurate without actually 
having to be tremendously skillful at drawing. 

Patterns 

MacPaint gives you a more than adequate number of patterns and also the oppor­
tunity to create your own. Once again they a re made up of combinations of dots and 
can be grouped to represent roof tiles, bricks and a whole range of other designs. Each 
can be used to fill areas, to draw lines and borders or as shading. 

Text 

Although it lacks the text editing facilities of Mac Write, MacPaint does give you the 
same style and font features as Mac Write and also lets you use larger font size - up to 
72 point. Generally, text is used for labelling and describing diagrams. It can, 
however, be helpful to use the larger font sizes which are not available in Mac Write. 

Overall! find MacPaint a very useful tool and not at all the gimmick I had expected it 
to be. Its limitations are mainly caused by the relatively small work area - the 
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window. Most of the time it is possible to overcome this by moving the window with 
the Hand tool. It is restrictive on occasions, however, when I want to transfer a docu­
ment from MacPa int to MacWrite and find only a window at a time can be moved. 
Also if you want to rotate a diagram which is as large as the window, turning it on its 
side means any part which extends outside the current window will be lost. In these 
instances, I wish that the facility to move diagrams could be extended to apply to the 
Show Page feature so tha t larger diagrams could be manipulated. 

Imagewriter 

Thus far I have really said very little about the Apple printer which I use . That's 
because it works so easily and so well that I don't have to think about it at all. I just 
switch it on, load it with paper and that's all there is to it. I have the l 0 inch model and I 
find it adequate for all my needs. 

In addition, if you study your Imagewriter User's Manual you will see that it is also 
possible to extend the features available to designing your own fonts. I haven't 
attempted this as the range already available is quite adequate for me. 

A final word ... 

My aim in this book has been to show you how the Macintosh can be used in business. I 
have shown you how to write letters, adverts a nd forms, to create diagrams to 
illustrate, inform and instruct. Along the way I got a good deal of enjoyment from 
discovering what Macintosh could do . I did not set out to cover every aspect of the 
Macintosh, but to select those features which I find I use the most. You may have 
found great uses for some of those which I have overlooked - I hope I have left some­
thing to your imagination. 

I have covered the only basic aspects of Macintosh -the software which comes with 
the machine. However, there are certainly other packages available - the 'Multi' 
series and two accounts packages MacCash and Mac Ledger , with a considerable 
number to come in the near future. I am certainly looking forward to getting my hands 
on them and testing Macintosh's powers further. 

Ill 
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